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Navigation

This document provides an overview of the basic template, navigation, common operations
that can be performed, and keyboard short cuts available in Oracle Financial Services Lending
and Leasing. Since this section details the general options available in the User Interface,
some or all the parts of this section are applicable to you as per access provisions & licensing.

# Note:

The application can be best viewed in 1280 x 1024 screen resolution.

The document is organized into below topics:
* Audience

* Conventions Used

e Logging In

e Template and Navigation

e Common Operations

e Keyboard Compatibility

e Tool Tips

e Accessibility

1.1 Audience

This document is intended to all Prospective Users who would be working on the application.

1.2 Conventions Used

Table 1-1 Conventions

Term Refers to
The system/application Oracle Financial Services Lending and Leasing
Mnemonic The underlined character of the tab or button

1.3 Logging In

The pre-requisites to log into the system are a valid user ID and a password, defined by the
system administrator in Administration > User screen.

You can login to the system using a valid user ID and a password defined by the system
administrator, in Administration > User screen. A User ID is disabled automatically by the
system if it is inactive for a specified number of days.

ORACLE 1



Chapter 1
Template and Navigation

When you invoke the application, the Sign In screen is displayed.

Figure 1-1 Login page

oracte: B o

Financial Services Lending and Leasing

e User ID — Specify a valid User ID.

» Password — Specify a valid password for the specified User ID.

The system accepts the User ID and password in upper case only. After specifying valid
credentials, click Sign In to sign into the application.

1.4 Template and Navigation

This section provides a brief input on the template and navigation of the system.
Details are grouped into two categories to enable easy understanding. These include:

¢ Home Screen

e Screens

1.4.1 Home Screen

Once you login to the application with valid credentials, the system authenticates the details
and displays the Home screen.

The Home screen consists of the following components:
* Header

* Left Pane

* Right Pane/Work Area

ORACLE 1o
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Figure 1-2 Home screen

RACH ‘
Financial Services Lending and Leasing

A~ EIREE ©

DashBoard

4 DashBoard
DashBoard
Users Productivity
System Monitor
Producer Analysic
Process Files

> Origination
» Servicing
> Collections
> WFP

» Tools
 Setup

You can view the application version details and copyright information by clicking About link at
the right bottom corner of the screen.

Figure 1-3 About

About

Orade Financial Services Lending and Leasing 14.3.1.0.0
Build OFSLL_14.3.1.0.0_8253

Copyright @ 1998,2017, Oracie andior is affiiates. All ights reserved.

Oracke and Java are registered trademarks of Oracle and/or s affiiates. Other names may be trademarks of thei respective owners,

are al t and intellectual
property laws. permited in your or allowwed by law, you may not use, copy, reproduce, translate, broadcast, modify, license,
transmi, distribute, exhibt, perform, pubsh or display any part,in any form, or by any means. Reverse engineering, disassembly, or decompiation of this software,
unless required by law for nteroperabilty, i prohibited.

The information contained herein is subiect to change wihout nofice and i not warranted to be error-free. If you find any errors, please report them o us in writing.

Ifthis is software or related documentation that is defivered fo the U S. Government or anyone ficensing it on behalf of the U S. Government, the following notice is
appicable:

U.S, GOVERNIENT END USERS:  including any operating system, integrated software, any programs instaled . andior

delivered to LS. 't end users are *commercial compi Acquistion Regulation and agency-
‘specific supplemental reguations. As such, use, dupication, disciosure, modification, and adaptation of the programs, Including any operating system, ntegrated
‘Software, any programs installed on the hardware, anc No.
other rights.are granted to the U 5. Government

“This software or hardware is developed for generaluse n a variety of nformation management appiations. i & not developed or intended for use in any nherently

dangerous applcations, creste a risk of | iy applcations, then you shal
be responsible 1 take il appropriate faisate, backup, redundancy, and other measures {o ensure s safe use. Oracle Corporstion and s affiistes. disciaim any
Habitty for icati

may 0 or nformation on content, praducts and services from i partes. Oracie Corporation and s
affilates are not responsible for and expressly disclaim all warranties of any kind with respect to third-party content, products, and services. Oracle Corporation and
5 afflites. wil ot be responsile for any loss, Costs, or damages ncurred due o Your access 1 or use of third-party conent, proGUEts, or Services.

| Qose

Header

In the Header, system displays the following:

* User ID that you have currently logged/Signed in. Click the adjoining drop-down arrow, the
system displays the following options:

ORACLE"
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Figure 1-4 User ID - Options

M Welcome, VAVAIDYA 3

hange Fassword

[
m  UserInfo - =

— Change Password — Click to change the current password.

Figure 1-5 Change Password

ORACLE"
Financial Services Lending and Leasing Change Passtword

User Ifo Iy =

> DashBoard

Origination

[oracke Fnancio Sevices Lending and Leasing

Change Password

> Servicng
> Collections
> wrp

> Tools

> setup

Specify the current password in the Current Password field and a valid password,
you wish to maintain as a new password, in the New Password field. Re-enter the
password in Confirm Password field and click Submit to change the password.

— User Info — Click to view the current user info.

Figure 1-6 User Info

"

| Oracle Financial Services Lending and Leasing *®
I
User Info
Organization DMC Time Zone (JSER TIME ZONE v
Division U501 Level
First Mame VARSHA User Time Zone UNDEFINED

Last Name  VAIDYA Company US/CENTRAL (CENTRAL STANDARD

Branch Time TIME)
Responsibility SUPERUSER s
R i il Server Time ASIA/CALCUTTA {INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)
Session Language DEFAULT r Skin Family Skyros (Default) T

Debug Enabled Ind

ELE; Submit || 2% Close
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In this screen, apart from viewing the user info, you can also set Session Language,
enable error log, and specify the time zone preference.

Session Language — Select a language that you need to set for the session, from the
drop-down list.

Debug Enabled Ind — Check this box to enable the debug indicator.

On selection, system records all the debugs into logs files depending on the following
two types of system parameters:

Table 1-2 System Parameter

___________________________________________________________________________|
System Parameter Condition to record debug data

CMN_DEBUG_METHOD If parameter value is 1, then debug data is
recorded into a file in Database Server.

If parameter value is 4, then debug data is
recorded into the table LOG_FILES_HEADER.

CMN_DEBUG_LEVEL If parameter value is greater than 0, only then
the debug data is recorded.

The debug data can be viewed from Dashboard > System Monitor > Database Server
Log Files.

You can click on 3= List Files button to view the list of logged files.
Figure 1-7 Database Server Log files

OoORACLE r me, PRAKRRA + (]
Financial Services Lending and Leasing

DashBoard »  System Monitor s [] Close
Batch Jobs  Jobs || Services = Database ServerLog Files | Parked Transactions | Users =
Database Server Log Files
view * Format~ [ Freeze  fi Detach il Wrap W) S=LstFiles  [E Download File
File Name File Type File Size File Time
JSVPRC_EN_000_01_DB12C_2084400 b 5706 02/18/2016 06:14:11 AD ~
ALERT lob 395 02/22/2016 03:59:16 Ar_|
CSVPRC_EN_100_01 DB12C_3794335 lob 6390 02/22/2016 04:53:00 AP 2
CSVPRC_EN_100_01_DB12C_3854338 lob 116750 02/22(2016 05:36:42 A
JSVPRC_EN_000_01_DB12C_20943562 lob 5706 02f18/2016 10:57:09 AP =
L
File Content
View v Format v Freeze  ff Detach o] Wrap o] ) Beginning @ End = oflines 50 [=] show File
Text

-

1

11: cmnsyp_cl_| .get_syp parameter value value: weblogic

1: emnsyp_cl_| .get_syp parameter value value: http://ofss2221142.in.oracle.com:

11: 45:FLL:1lv use BI::¥

¢ cmmsyp cl | .get_syp parameter value value: http://ofss2221142Z.in.oracle.com:

:11: cmnsyp cl | .get_syp parameter value value: /scratch/work area/DEV/QRI43REL/r 3
¢ cmnsyp cl 000 Ol.get syp parameter value parameter: J5V _BI USER
/_ REPORT ARCHIVE DIRECTCORY

/_REPCRTS SERVER TIMECQUT

:11: cmnsyp cl 000 0l.get_syp parameter value parameter:

1e parameter:

1: cmnsyp cl 000 0l.get_ syp paramete

Click on El Show File button to view the selected file contents in the File Content

%

section. You can also click
details.

Download File button to extract a copy of debug
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Time Zone Level - Select the time zone preference as User/Company Branch/
Application Server Time Zone from the adjoining options list.

For more details on time zone selection, refer to Time Zone Preference section of this
user manual.

Click Submit to save the changes or Close to close the screen without changes.

* Accessibility — Click the link to view accessibility features of the system.
Refer accessibility document for further details.

* NextGenUI - This is Next Generation User Interface option which is an enhanced interface
provided in OFSLL using the Oracle JavaScript Extension Toolkit (Oracle JET) frame work.
This is an additional interface supported from OFSLL to the existing system and both
intended to coexist in the system till further updates.

This option is enabled only if the corresponding system parameter is enabled in the base
system as configured by your system administrator. For more information, refer to
Appendix - Oracle JET Interface section in Servicing guide.

*  Sign Out — Click the link to sign off from the application. You can also click on

icon to sign off from the application.
Left Window

In the left pane, system lists and provides drop-down links for various modules available in the
product. Click ~ to expand the Module Master Tabs and “ to collapse them.
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Figure 1-8 Left Pane

» DashBoard
> Origination
Servicing
Eervidng =
Customer Service
Securitization
Transaction Autharization

Post Date Checks
Escrow Transactions

m

Account Documents 4
Collateral Management
Reports

Producers

Vendors
Batch Transactions
Interfaces
AP Transactions

GL Transactions 57

» Collections
= \WFP

> Tools

» Setup

To open a screen, navigate to Module Master Tab to which the screen belongs, expand the
tabs, and click the screen link you wish to open.

Menu Search in Left Window

In the left window you can make use of the search option to directly search and open the
screen that you are familiar with, and avoid multiple steps of navigation from the LHS menu.

The Search box in the LHS facilitates for an intuitive search of required screens in Oracle
Financial Services Lending and Leasing. For example, on typing the first letter of the screen,
the search box displays a list of all available screens starting with the letter entered in
alphabetical order. You can click on the required screen and press Enter. The screen is
displayed in the main window/work area.
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Figure 1-9 Left Pane Search

ORACLE w BR « g sgnout ©
Financial Services Lending and Leasing
Al @0 | Access » 36 Close
Appiication Retrieval (Originatior) Data | Screen | Reports || Correspondence | Transaction
Application Documents(Origination)
Asset Types(Setup Products) Access Grid opadd | et || [E vew | o Audt
Aot DeametsGeanl View v Format~ [ Freeze i Detach wrap W
U
=3l o i Division Company Branch Mlowed
AP Transactions(Servidng Interfaces) DMC UsoL ALL AL ¥
Application Entry (Origination) oMe NLOZ AL AL Y
Audit Tables(Setup System) oMe a0z ALL AL v
Advances(Servicing Batch Transactions) oMC P04 AL AL ¥

> Origination
> Servicing
> Collections
> WEP

> Tools

> Setup

When there are multiple matches with same screen name, you can filter the results through the
module from which the screen is accessed which is indicated in angular brackets. For example
typing VEN displays the following options for selection - Vendors(Collections),
Vendors(Origination), Vendors(Servicing), Vendors(Setup System). For subsequent search,
you need to clear the data in the search field.

Right Window

The Right Window can also be termed as work area. When you click the screen link on left
pane, system displays the corresponding screen in the right pane.

Figure 1-10 Right Pane

opacie )

Financial Services Lending and Leasing

Close
> DashBoard Sales Lead x £l
Origination Lead Entry | Follov-Up | Maintenance

Origination
Sales Lead Applicant Information P add | Aedt | Elview |  audt
Simple Application Entry
View v Format v Freeze Detach &l Wrap
Application Entry 2 4 o @
Unsiasiaitis Lead Lead Dt Company Branch First Name. Last liame Birth Dt Channel Source Type Country Address = city
ey L-00002008 115/2015 N2 g ROSEMARY BLACK 1081367 CONSULTATION  WEB ENTRY HOME UNITEDSTATES 813w Juncos
L T L-00001002 1022015 uso uskQ TEST TESTLASTRANE  01/03/1990 ESTATE AGENT UNITEDSTATES 1000 PLYMOU
s sl L-00003002 12/17/2015 usot uskg ] JanEs 01/01/1997 UNITEDSTATES 1000 BOTHEL!
s L-00002002 12/12/2015 uso1 UsHQ PHANINDRA CHODA 10/10/1982 CONSULTATION UNITED STATES 89898 IRVINE
L-00002004 12f12/2015 uso1 UsHQ BOREN ROBERT 1203/1970 UNITED STATES Juncos
L-00005002 02/03/2015 uso uskQ o] 305H1 07125/1988 CONSULTATION UNITEDSTATES  ADDL coaro
Loo003004 1211912015 uso1 uskQ ANDRES MARTINEZ 08/06/1989 ConsuLTATION UNITEDSTATES  LEAD ENTRY Loza
Lo000s002 1212312015 usor uskQ san sam 11/13/2991 oTHERS VIEB ENTRY HOlE UNTEDSTATES 123 PONCE
‘endor
»
Telecoms = Comments = Documents —Requests
‘
Telecom Information A add || A Edit | 5 view || o Audit
Vieww Fomate B | [[Freeze BiDetah  Jwrs @)
Telecom Type Phone Current.
(CAR/MOBILE PHONE (o0sys32:3423 ¥

> Servicing
> Collections
> WFP

> Tools

> Setup

You can open a maximum of 15 screens at a go. Once the maximum limit is reached, the
system displays an error message.
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Figure 1-11 15 Screens

ORACLE" # Welcome, VAVAIDYA + o
Financial Services Lending and Leasing
P 0] <y [Transaction Authorization x | Post Date Checks x | Escrow Transactions » || Account Documents ¢ | Collateral Management x | Reports x| Producers x | Advances x| Paymentsx | Feasx | AP Transactions x || GLTransactions x ~ 0
> Origination Authorization | Authorization History Review Requests (Pending: 0}
Servicing
Transactions Z Edt | Bl view | o audt
Vieww Formatv [ Freeze i Detach wrap @) @ Checker O Maker C) Both ® 1Day (0 2Days () 5Days O AllDays  viewFailed (] §8%Post [El void
Account = Txn Dt Transaction Status Maker Initiated Dt Checker Authorized Dt Comments
20150200010030:KARTHIKRAGHAVEIL.. 02/10/2015 ACCOUNT CLOSE ERROR ViEHATIA 02/10/2016 UNGEFINED
20121000010585:8ROVN PAUL/ PAULA 02/09/2015 CHARGED OFF ERROR VEROUTHU 02/09/2016 UNDEFINED
20160100014008:B00 SUMAN 02/09/2016 CHARGED OFF ERROR VEROUTHU 02/092016 UNDEFINED
Collateral Management
Repwts Parameters
ik g View v Fomat~ [ Freeze f7f Detach wop | @@
Parameter Value Required
TXN DATE 02/09/2016 L2

4 Transaction Processing Details

Vieww Format~ B Freeze L Detach rap 5]

> Collections
> WEP
> Tools
> Setup

Each active screen is displayed as a tab at the top of right pane, across its width. To view a
screen, click the screen tab. You can identify the active screen with its white background. Also,
operation on any of the screen will not affect the data in other screens.

Few screens in WFP are identical and are linked. Hence, when multi tab option is not enabled,
you can open only one screen at a time from the group. A sample of the grouping structure is
given below, based on stages of the screens:

WFP

¢ Producers
e Credit Lines
e Units

As per the above listing, you will be able to open only one screen in the corresponding list and
need to close the same to open any other screen.

Right Splitter/Action Window

The Right Splitter/Action Window has quick access to search and other options to avoid
switching between tabs or navigating into sub tabs periodically. You can access the Right
Splitter/Action Window while working on Application and Customer Service screens. You can

click {and b to toggle the view of Right Splitter/Action Window.
Origination Screens

In Origination > Application screens, you can use the Right Splitter/Action Window to do the
following:

1-9
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Figure 1-12 Right Split Window Application

ORACLE i #, Welcome, VAVAIDYA v o
Financial Services Lending and Leasing
Close
 Dashoard originstion x ®
Search/Task  Fundings 0000000378  Review Requests (Pending: 0) B
Quick Search
Application: 0000000378 TIFFANY RUSSEL / GRACE (Bl view || 2 audit et
Vieww Fomatw [ Freese 5 Detach wiap | @) OverideoK ¥ WamingOK v e
Origination Stage b Duplicate Itiadcy
Dt App = Sub Unit Status Code Producer Name r[‘: Existing Customer Aapplication Contact * Eﬁ T é[\ear
lication Retrieval 01/01/2012 0000000378 UNDEFINED /APPROVED - FUNDED FUNDED (GA-00004 : ADVANCE LEA. N N
cenario Anlysis » Summary
Application Documents s e
image Mainterance Advance 15,000.00 15,000.00
Reports s
Producers summary || Applicant || Request | Decision | Contract | Collateral || Comments | Tracking | Document || Verification || Correspondence | Tools ’:““ i:“”“ ;E“““
em
Vendors
> Applicant Grade DGRADE  Score 0
v o1seo L2 15000
Stated PTI954 Stated After DTS8.92
4 > Ratios Book 10,000 ileage 0
AssetDesc 2012 CHEVROLET MONTE CARLO
= 0
> Bureau
Quene FUNDED APPLICATIONS QUEUE
B Cheniaet Change Status
Status APPROVED - FUNDED
Collateral Change Status
Collateiml Add Comment
hsset Type SubType Primary  Year vake Wodel Vileage New Wholesale Value =
> Servicing VEHICLE car v 12 CHEVROLET MONTE CARLO N 10,000.00 Blert
> Collections “Trpe
s * Sub
AWER Trade-In Type
> Tools * Comment
> Setup Trade-In - -

* Use Quick Search to search for an application based on application number, last 4 digits
of SSN (SSN of the primary applicant) or identification number. If multiple applications or
accounts are found during Identification # search, the system displays an error message
as “Multiple Matches found for the Identification #, Please use normal Search”.

*  Summary section displays critical information that has to be referred repeatedly during
origination like — DTI, PTI, Book Value, Grade, FICO Score, Approved Advance, Rate and
Term.

* Use Change Status section to change the application status to next level. If the
application edit status is restricted, then the Change Status will be read-only.

* Use Add Comment section to post an alert or comment during Underwriting and Funding

stages.
For detailed information on the above options, refer to respective sections in the document.

Servicing and Collection Screens

In Servicing and Collection > Customer Service screens, you can use the Right Splitter/Action
Window to do the following:
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Customer Service
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Cangany At = roduct Oays pastoue Curency fayOffAmt  Amountue Staus Odestoue0t  DLQResn
sot 017010010057 LOANVEHLE (%) 1538155 200,21 (ST o=/ 017 15T PAENTDEL

Conditions,

Conditions

DELINQUENT

Other Information

Collateral Information

prmory  Desrpton Mottt Nex AstCass AsstTe  SbTye b
v 206 CHEROLETHONIECARO DR 284GPA5GIRIT252. 2005 NeW wice  om
Customer Information BPostcomment | [ @ Cear
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% e st son T Gonder 'Add Call Actiiy
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=
RSIGGHALL COM 2
s =
osne stop Care
Address Information 5]
mmmmmmm o
T T o
rove Y Y snemokasw s Y
=]

Employment Information

s5/Up Sel Actvites | | Externa Interfoces

[ swomit | [ @ Cex

Queue/ Condtion ~|
AR
[ et et
CondtonSutot om0t
wmmn wmm
oarmmsy

[ St At

08/18/2017 Add Comment
slre

“Type ReaR 2]

*SiTye =

Brostcalacity | [ goes

e Use Quick Search to search for an account based on account number, or customer Id, or
last 4 digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during Identification # search, the system displays an
error message as “Multiple Matches found for the Identification #, Please use normal
Search”. You can also select the Queue Condition and Auto Run options during search.
Clicking Next Account button opens the subsequent account listed in search and clicking
Filtered Account opens the subsequent account fetched during a queue search and listed

in Queue Assignment section.

* Use Add Comment section to post an alert or comment based on Type and Sub Type.

* Use Add Call Activity section to post all types of call activities including promise to pay,
account conditions and so on, irrespective of the screen you are working on. This is similar
to the option available in Call Activities sub tab under Customer Service tab.

For detailed information on the above options, refer to respective sections in the document.

The height of Header and width of the Left and Right Panes do not change, with resizing of

application screen.

The system facilitates toggling Header and Left and Right Panes of the home screen to
increase the visible area of the screens. Click = to toggle upper pane and {to toggle left pane.
To un-toggle click == and 3 respectively.

This section consists of the following topic:

 Time Zone Preference
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1.4.1.1 Time Zone Preference

Figure 1-14 User Info

| Oracle Financial Services Lending and Leasing *®

User Info
Organization DMC Time Zone USER TIME ZONE r
Division US01 Level
First Mame VARSHA User Time Zone UNDEFINED
Last Name VAIDYA Company US/CENTRAL (CENTRAL STANDARD
e Branch Time TIME)
Responsibility SUPERUSER p S
L Bosz Mste I 2014 Server Time ASIA/CALCUTTA (INDIA STANDARD
Last Legin Date 02/10/2016 03:21:07 AM Zone TIME)
Session Language DEFAULT X Skin Family Skyros (Default) v

Debug Enabled Ind

B3 submit || 3% Close

You can select any of the following three time zones from the User Info screen:
e Application Server Time Zone
e Company Branch Time Zone

e User Time Zone

The time zones set up at each of these levels are displayed in the user info screen. However,
data is always stored in the application server time zone and based on the user preference of
time zone, the display time would be User or Company or Application Server time zone. Any
time zone related changes done at Ul does not impact the other time bound activities which
are dependant on database time.

Application Server Time Zone (Server Time Zone)

The Application Server Time Zone by default is the Production Server Time Zone. Selecting
this time zone will have all date and time fields defined as per the time stored in application
server. There is no offset in time if both storage (database server) and display (application
server) are in the same time zone.

Company Branch Time Zone (Organization - Division Time Zone)

This is the Company time zone and is setup at the organization - division definition level. The
various divisions defined under an organization can be set up with different time zones
depending on geographical locations. This time can be modified as per requirement.

To modify the Company Branch Time Zone:

e Navigate to Setup > Administration > User > Organization and select the company or
division listed under Division Definition.

e Inthe Display Formats tab, select Time Zone and click Edit.
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* Inthe Format field, select the required time zone from the adjoining options list and click
Save.

If Company Branch Time Zone is selected as the time zone in User Info screen, then on
save, all the time and date fields are automatically updated with the time zone of the company
branch.

User Time Zone

User Time Zone or User Preference Time Zone can be set up at the User Level in the User
Definition screen. Various Users under same divisions defined under an organization can be
set up with different time zones depending on geographical locations.

To modify the User Time Zone:
e Navigate to Setup > Administration > User > Users.
«  Select the required User record listed in User Definition section and click Edit.

* Inthe Time Zone field, select the required time zone from the adjoining options list and
click Save.

If User Time Zone is selected as the time zone in User Info screen, then on save, all the time
and date fields are automatically updated with the current updated time.

1.4.2 Screens

Details in few main screens are grouped into different sections. These sections are displayed
as tabs, horizontally within the screen. In turn, details in few of these tabs are again grouped
horizontally. The details are displayed when you click the tab under which they are grouped. As
similar to the main screen tabs, you can identify the active tab with its white background.

For example, Customer Service main screen has four main tabs. When you click on Customer
Service tab, the corresponding tabs are displayed.

Figure 1-15 Customer Service_Example

Customer Service x [Fcle
search  Customer Service: 0120200010231 PeweuRequest(venqu:n)l
Account(s): 20120200010231: YUTAKA OZAKA / AKANE Elview || o avdit
Vieww Format~ [Ep Freeze i Detach Wrap B & © cument O Showall O Group Fallow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
usot UsRL UNDEFINED 2012020010231 LEASE VEHICLE 0 UsD 0.00 0.00 ACTIVE 02/10/2015
[ summary ICustomer Servicd _Account Details _Customer Details _Transaction History Pt Modes | Bankuptcy | RepofForedosure Deficiency  Collateral Bureau _Cross/lp Sell Actvties |
‘ Call Activities ~ Maintenance =~ Comments Promises Checklists Tracking Attributes ~ References  Correspondence  Letters — Document Tracking
Call Activities . Fadd || et || Eview || o audit
View= Format~ [y Freeze i Detach wrap M

Action Result Contact Reason Cancel Promise Dt Promise Amt Condition Appointr Followup Dt Time Zone Adj Followup Dt Cor
AT PH ANSWERING MACHINE N 12/30/2015 1,000.00 NONE N 12/30/2015 12292015 12:30:00 PM
AT PH ANSWERING MACHINE N 12/30/2015 1,000.00 NONE N 12/30/2015 12/29/2015 12:30:00 PM

»

You can click » to view the hidden tabs, if any.

1.5 Common Operations

Some of the operations are common to most of the screens.

These are grouped into following categories, based on their features.
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e Basic Operations

e Basic Actions

e Personalization Options

*  De-supported Special characters
e Skip Zip Code Validation

*  Export data to Excel

1.5.1 Basic Operations

All the screens contain buttons to perform all or few of the basic operations. The four basic
operations available are:

e Add
e Edit
*  View
*  Audit

ok add | A Edit | 5] view || < Audit

When you click any of the operation tabs, system displays the corresponding records inline,
below the respective setup tables.

The table below gives a snapshot of them:

Table 1-3 Basic Operation

]
Basic Operation Description

Add Click to add a new record. When you click Add, the
system displays a new record enabling you to
specify the required data. It is mandatory to specify
details for the fields marked with ** symbol.

Edit Click to edit an existing record. Select the record
you want to edit and click Edit. The system
displays an existing record in editable mode. Edit
the required details.

View Click to view an existing record. Select the record
you want to view and click View. The system
displays the record details in display mode.

Audit Click to view audit info. If an audit is set for a field,
then the system tracks the changes for that field.
Select the record for which you want to view the
audit info and click Audit. The system displays the
details tracked for that field.

Close Click to close a screen or a record. When you try to
close an unsaved, modified record, then the system
alerts you with an error message. You can click Yes
to continue and No to save the record.

1.5.2 Basic Actions

Most of the screens contain buttons to perform all or few of the basic actions.
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All or few of these actions are enabled when you select any of the Basic Operations.

El Save and Add E Save and Stay El Save and Return <3 Return

The table below gives a snapshot of them:

Table 1-4 Basic Actions

_________________________________________________________________________________|
Basic Actions Description

Save And Add Click to save and add a new record. This button is
displayed when you click Add button.

Save and Stay Click to save and remain in the same page. This
button is displayed when you click Add/Edit button.

Save And Return Click to save and return to main screen. This button
is displayed when you click Add or Edit buttons.

Return Click to return to main screen without
modifications. This button is displayed when you
click Add, Edit or View buttons.

The summary screens consist of the following navigations. The table below gives a snapshot
of them:

Table 1-5 Navigations

Basic Actions Description

Click to navigate to the first record.

Click to navigate to the previous record.

Click to navigate to the next record.

b |

M |

Click to navigate the last record.

Along with the basic actions, the following buttons are available for specific actions. The table
below gives a snapshot of them:

Table 1-6 Buttons for Specific actions

Basic Actions Description

Show File - Click to view the details of selected file.

E
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Table 1-6 (Cont.) Buttons for Specific actions

Basic Actions

Description

List Files - Click to generate and view the list of
files maintained in the system.

Download File - Click to download the details of

E‘ selected data.

1.5.3 Personalization Options

You can personalize the data displayed in setup tables. Once personalized, system saves the

settings for that User ID until next personalization.

Figure 1-16 Personalization Operations

|\n'iewY Format » | P Freeze &= Detach U Wrap EE!'

The table below gives a snapshot of them:

Table 1-7 Personalization Options

Options

Description

View

Click to personalize your view. The drop-down list provides the following
options of customization:
e Customize columns you wish to view

e Sort the order of displayed data
e Reorder columns

Additionally, the drop-down list provides selection of options adjoining
View.

M Format ~ | Ep Freeze £ Detach

Columns * Show Al
| R + Product |
Detach + Description |
Sort v« StartDt
Reorder Columns... + End Dt
Query By Example + Direct
+ Enabled

+ Collateral Type

+ Collateral Sub Type

+ Credit Bureau Portfolio Type
+ Credit Bureau Account Type

Manage Columns...

ORACLE
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Table 1-7 (Cont.) Personalization Options

Options

Description

Format

Click to resize columns or wrap a data in the table cells.

Select the column you need to resize and select Resize Columns
option from the Format drop-down list.

Resize Column =

Column DESCRIPTION
width [ 100 & [Pixels  [=]

| OK | Cancel

Specify the Width and unit for the selected column. Click OK to apply
changes and Cancel to revert.

Query by Example

Click to query for the data by an example. When this option is selected,
the system displays an empty row above column heads. You can specify
all or any of the details of the record you wish to query.

View » Format #
¢ |

Freeze Eff Detach ol Wrap [ee)

| @) EY

Freeze

Select the column at which you need to freeze the table and click
Freeze. Function is similar to the freeze option in MS excel.

Detach

Click to detach the setup table from the screen. An example of the
detached table is provided below.

Wrap

Select the column in which the data needs to be wrapped and click
Wrap.

Loan Line Lease

Product Definition shadd | et | [Even | o st
vew - [femetsl B | @I e [ | @ e Procuct Create Copy
| I redit Bure
|Product Jendot [prect [reutie Repayment |ereed [ctoterairype  [cotetera sorpe [Sedtpees |
M LoAN+HE 12/31/4000 Y bé L4 HOME COLLATERAL REAL PROPERTY HOM INSTALLMENT I
LoANsE 12/31/%000 N N v HOUSEHOLD GOCDS PERSQNAL PROPERT INSTALLMENT
|
|
LOANAN 12/31/4000 4 \ ¥ UNSECURED COLLATINSECURED peTALET E
LOAN-VE 12/31/4000 N ¥ ¥ VEHICLE COLLATERA PERSONAL PROPERT INSTALLENT -~
voP 1 12/31/000 v N ¥ VEHICLE COLLATERA PERSONAL PROPERT INSTALLVENT
MURABAHA 03132013 v N ¥ HOME COLLATERAL REAL PROPERTY HOMINSTALLMENT
nDS1 12/31/%000 v N 3 UNSECURED COLLATIUNSECURED INSTALLMENT
PO 12/31/%000 Y N 12

HOME COLLATERAL REAL PROPERTY HOMMORTGAGE -
i ,

Click to refresh the data in the table.

ORACLE
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Table 1-7 (Cont.) Personalization Options

________________________________________________________________________________|
Options Description

View Last For usability and performance, some of the data intensive screens have
View Last option to sort the volume of data being displayed on screen
based on elapsed days.

view Last ©) 1Day @) 1Week© 1Month@ By Date startDt 07/01/2017 [ EndDt 092002017 b &B

You can select the View Last option as 1 Day / 1 Week / 1 Month / By
Date. When By Date is selected you can specify a date range (within 3
months) in Start Dt and End Dt fields using the adjoining calendar and
clicking Search.

Print option in Customer Service screen

The Print button option in Customer Service/Collection screen facilitates you to print
the contents on the screen as is without scroll bars. This button is available along with other
options in the Action block. Clicking on this provides a browser print functionality and a new tab
is opened where the print content is displayed.

Detach

Figure 1-17 Detached Table

ORACLE" & Welcome, vavarova ~ EISEGRIGN <
Financial Services Lending and Leasing
& Close
e 13 " customer service =
> Origination | : 1 :0) =
Account(s): 2012020001023 1: YUTAKA OZAKA / AKANE [Elvew || 2 audit
View+ Format~ [ Freeze Pfivetach  Jwep @ & @ Cument O ShowAll O Group Follow-up
Company Branch Sub Unit Account = Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
usot USRL UNDEFINED. 2012020010231 LEASEVEHICLE 0 usD 000 0.00 ACTIVE 02/10/2015
Summary | Customer Service | Account Details | Customer Details | Transaction History Pt Modes || Bankruptcy | RepofForeclosure || Deficiency | Collateral || Bureau || Grossfup Sell Actties
Call Activities | Maintenance || Comments || Promises || Checists | Tracking Attributes || References || Correspondence | Letters || Document Tracking
Reports
Producers E ?
Visidors Transaction Batch Information padd | S Edt || [Eview || o audit
e View Formats | B Freeze B Detach war | @ S post [ vaid
Date Honets Transaction Status Batch
Payments 02/10/2016 ADD CUSTOMER ADDRESS PHONE POSTED N
Fees g 75016 v TERMINATE ERROR [
Interfaces 01/06/2016 v TERMINATE vo u «
P Trane 010EPY6 ECENSION van L
Detached Table
View~ Format~ B} Freeze [0 Detadh rap W@ #3post [} vaid
Date Honetary Transaction Status Batch
02/10/2046 N 'ADD CUSTOMER ADDRESS PHONE POSTED
01/07/2016 Y TERIINATE ERROR i
01/06/201 v TERMINATE vom [
01/06/2016 Y EXTENSION vom i
127242015 v PAYOFF QUOTE LEASE POSTED ¥
View~ Format~ [ Freeze f Detach wep | @
> Collections rocessing Details
> wEp Direct Record Update, Transaction Posting Successful =+
> Tools
> Setup

Click Add, Edit or View button to open a new screen in expanded mode with details.
Drop-down List

The system provides an option to select the required data from LOV, for few fields. You can
either select the record from list or enter first alphabet of the value you want. When you provide
the alphabet, system limits the selection to the values starting with the specified alphabet.
These lists are grouped into two types:
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»  Drop-down list — Provides the selection option. You can either select a record from the list

or enter first alphabet of the required value.

e Combo drop-down list — The LOV contains huge data and provides both selection and
search option. These drop-down arrows are smaller in size, when compared to normal
drop-down arrows, thus enabling easy identification.

Figure 1-18 Combo drop-down

ORACLE & welcome,vavaons - =)
Financial Services Lending and Leasing
Close.
T Customer service EE
> Origination 2rerEn| © :0)
Servicing
= Account(s): 20151200010012: MADHU BOBBURI Eview [ 2 auit
Views Fomatv [ | [[[Freere EiDetach  clwap | @ & © Curent O Showl O Group Follov-up
Company Branch Sub Unit Account & Days Past Due Currency Pay Off Amt Amount Due Status. Oldest Due Dt
usor useg 2015120001012 LOANVEHICLE (FR) s031851 EEEEN 2 Crive:0EL0:von pero . [SIIERTY
Account Documents QUSR] | Customer Set Acotprtats) [loms *
Collateral Management
gement Call Activities | Maintenance | Comments P
Reports o
Transaction Batch Information e add ||/ dt yi & Audit
View~ Fomatv [ Freeze ot Detach Wrap (5] #rost [ vaid it
Date Monetary Transaction AcComTC r 'y
02/10/2016 ¥ ACCOUNT e Search: Transact
‘ 01252015 [ ACCOUNT SUB UNIT TRANSFER P rilies
01/22/2016 N ACH MATNTENANCE > Search Basic
o1/07/2016 N ACH ONE TINE PHONE PAY
12/15/2015 v ADIUSTMEIT TO ADVANCE | PRINCIPAL - ADD

Transaction Batch Information

Parameters

> Collections e | 3
P

> WEp o data to dicplay

> Tools

kiseum Result

Date
* Monetary

02/10/2016
C)

ceze ffi Detach wep @

Reset | | AddFields ~ || Reorder

an or equal to o || cancel

Click the arrow button available before Search to toggle the search options.

Table 1-8 Search options

Buttons/Menu Do this

Basic Click Basic for normal search.

Advanced Click Advanced for advanced search. In this mode,
you can select the search option from drop-down
list adjoining the search criteria. Selected record
will be highlighted (Hover to select).

Match Select All to display results exactly matching the
specified characters. Select Any to display results
matching any of the specified characters.

Search Click to search for values based on the specified
search criteria. The search results are displayed
below with the details in respective columns.

Reset Click to reset the search criteria.

Add Fields Click to add additional fields to search criteria.

The search criteria are provided below the Match field. These criteria vary based on the Field
for which the search is executed.

Also, the system remembers your recent search options and demarcates them from the actual

ones.

ORACLE
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Figure 1-19 Search Memory

| * Channel | WEB ENTRY [=] * Producer Name |
NY-02 : PR : HOLTSVILLE 43125313712
MT-00001 : SGFSADDF RAMEY 23132132
LR} SR e 1
TIF-OUOO L T TEST-00 T AOTONTAS T 1
MN-00001 : TERMINATE AGUADA a
MT-00001 : SGFSADDF RAMEY 23132132
NY-02: PR HOLTSVILLE 43125313212
Search...
Comments

In all the user input screens wherever comments are accepted, the system allows an input of
4000 characters of information in the comment(s) field.

1.5.4 De-supported Special characters

OFSLL does not support the following special characters while accepting data through Ul,
web service and file upload process.

<>{}N\"[I

Hence, ensure that the same is not used while processing any input data in the system.

1.5.5 Skip Zip Code Validation

ORACLE

While accepting data for interdependent fields through User Interface, OFSLL validates and
auto-populates the values for subsequent fields based on previous selection.

Accordingly, when a specific Country is selected from drop-down list which is populated based
on COUNTRY_CD (COUNTRY CODE) lookup code, OFSLL validates and populates the list of
corresponding zip codes maintained in Zip Code setup.

However, in case the zip code validation is to be skipped for a specific Country, then define the
Sub Code as NO_ZIP_VAL against the COUNTRY_CD in lookups screen as indicated below:

Figure 1-20 Skip Zip Code Validation

Lookups x (3] Close
Lookup Type H Add | A Edit || [F] view || & Audit
View v Format » E Freeze ;f Detach Wrap E@

Yes

& “COUNTRY%
No

System Defined

Lookup Type Description Yes/No Enabled
COUNTRY_CD COUNTRY CODE (SORT BASED ON CODE) Yes () No Y
»
Lookup Code P Add | FEdit | ] view || & Audit
View v Format « @ Freeze ;ﬂ Detach Wrap GE
é Yes
%NOY
%NO% No
Lookup Code Description Sort Sub Code SEEmEEEY Enabled
Yes/No
UK UNITED KINGDOM 1|NO_ZIP_VAL Yes (L) No Y|
SG SINGAPORE 1|NO_ZIP_VAL Yes () No Y~
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On Selecting that particular Country from drop-down in any of the Ul screen, only the default
value ‘0000000000’ is available for Zip field drop-down list. On selecting the same, the City and
State fields are set as UNDEFINED.

Figure 1-21 Skip Zip Code Validation

Producer Details
B Save and Stay B Save and Retun CJRetum

Producer # CO-00004 Address Line 12145 HWY 50 WEST Max Float 99,099
Old Producer # CO-00004 Address Line 2 Remaining Float 99999
* v
Name DALE SPRADLEY MITSUBISHI Country UNITED KINGDOM 5 Enabled
Company  ARGOL v
pEy, Zip 0000000000 hd <Subvention Participation
Branch ARO1 v ) 0000000000 UNDEFINED UNDEFINED
Zip Extn
Start Dt 05/27/1004 [y " Search..
City [ONDErTNED =i
End Dt 12/31/4000 | )
State UNDEFINED v Collection Type | STATEMENT v
Contact  JACK * Permission hlgi Collection Frequency MONTHLY 34
Group | NOT DEFINED X . Perm\ssioncic Refund Disbursement NONE v
Method
Grade hd Text o i =
egion
Type DEALER ¥ Phone 1 (719)-543-6710 N
Territory | ALL ¥
Status | ACTIVE v Bn10 i,
Sales Agent i * Permission to License Details
Underwriter DEMO UNDERWRITER v call
* Permission g
Funder v S ot Valid From |01/01/1800 [2:)
Collector ' DEMO COLLECTOR v Phone 2 Valid To 12/31/4000 B

# Note:

Skipping zip code validation has significant impact in the system since the change
impacts all the Ul screens - Setup screens, Origination, Servicing and Collection
module screens, Interface, Customer Credit Limit, Collateral Management, and so
on. Hence it is recommended to be done with careful consideration and OFSLL is not
responsible for any impact/ mismatch resulting out of this change.

1.5.6 Export data to Excel

While working on any of the screens in User Interface, OFSLL provides a flexibility to Export
the data that is displayed on screen to an Excel file. This helps to download and view the data
offline especially with data intensive screens.

Clicking Export to Excel option provides option to save the data to . x1s file.

Figure 1-22 Export to Excel

Summary = Collections ~Customer Service = Account Details ~ Customer Details =~ Customer Preferences =~ Transaction History = Pmt Modes = Bankruptcy = RepofForeclosure | Deficien > ¥

Call Activities Comments Promises = Checklists =~ Tracking Attributes ~ Field Investigation = References = Correspondence =~ Letters = Document Tracking = Scen: > ¥

Transaction Batch Information Padd | AEdt | [ view | o Audit
View v Format v E”"f' Freeze ;f Detach Wrap @ o8 Post % Vaid
Date Monetary Transaction Status Batch
10/29/2020 ¥ PAID OFF POSTED N
10/23/2020 N ADD CUSTOMER ADDRESS PHONE POSTED N

Parameters
View v Formatv  [Ep Freeze 4l Detach Wrap o)
Parameter Value Required
TXN DATE 02/11/2020 Y
WRITE OFF INDICATOR YES Y
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However, Export to Excel option is currently available only to following screens and is also
access controlled depending on configuration defined in setup.

*  Queues/Search Results - Origination, Servicing, and Collections
e Account Information

e Balances

e Call Activities

* Maintenance

*  Promises

e Due Date History

e Collateral

e Tracking Attributes

*  Condition Details / Condition / Queue History

In additional, OFSLL displays the total count of records fetched from database. The count is
displayed in the right bottom corner of records table. However, note that this is not the total
count of all the records in the database but only the records which are fetched based on
specific selection. For example, if there are 50,000 records in database and Ul is fetching
1,000 records, then the count is displayed as 1,000.

1.6 Keyboard Compatibility

The system facilitates keyboard compatibility. You can perform most of your tasks using
keyboard short cuts also termed as Hot Keys. These hot keys are single keyboards or a
combination of keyboards. The available options are listed below:

1. Shift + Alt + mnemonic to activate buttons in the screen. For example, to open
Accessibility screen, press ‘Shift + Alt +y'.

2. Tab for forward navigation in the application. Shift + Tab for backward navigation in the
application. When the required link/tab/button/field is highlighted, press enter on the
keyboard to edit.

3. Space bar to check or uncheck Check Box.

4. Arrow Keys to hover within the drop-down list.

* Keyboard Compatibility

1.6.1 Keyboard Compatibility

ORACLE

The application is made compatible with keyboard only-operations. However, there is a change
in key combination based on the browser on which the application is running.

Table 1-9 Keyboard Compatibility
]

Browser Operating System Key Combination Action

Google Chrome Linux Alt + mnemonic Click

Google Chrome Mac OS X Control + Option + Click
mnemonic

Google Chrome Windows Alt +mnemonic Click

Mozilla Firefox Linux Alt + Shift + mnemonic  Click
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Table 1-9 (Cont.) Keyboard Compatibility

Browser Operating System Key Combination Action
Mozilla Firefox Mac OS X Control + mnemonic Click
Mozilla Firefox Windows Alt + Shift + mnemonic  Click
Microsoft Internet Windows Alt + mnemonic Set focus
Explorer 7
Microsoft Internet Windows Alt + mnemonic Click or set focus
Explorer 8
Apple Safari Windows Alt + mnemonic Click
Apple Safari Mac OS X Control + Option + Click
mnemonic

Also, one can use the following keyboard shortcuts in order to increase or decrease the zoom
level.

Table 1-10 Keyboard shortcuts

Shortcut Action

Ctrl++ To increase zoom level.

Ctrl+- To decrease zoom level.

Ctrl+0 To set zoom level to default level.

1.7 Tool Tips

The system is facilitated with tool tip option.

When the cursor is moved on any of the user interface field in the screen, a popup is
displayed. It consists of a tip with the action that has to be performed.

1.8 Accessibility

This section consists of the following:

* Understanding Accessibility
* Application Accessibility Preferences

*  Documentation Accessibility Preferences

1.8.1 Understanding Accessibility

Accessibility is making the application usable for multiple user groups, which includes users
with physical challenges. One of the most important reasons to make the application
accessible is to provide them the opportunity to work. The four main categories of disabilities
are visual, hearing, mobility and cognitive.

A person with disability might encounter one or more barriers that can be eliminated or
minimized by making the electronic information user-friendly and approachable.
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1.8.2 Application Accessibility Preferences

Oracle Financial Services Lending and Leasing is facilitated with the feature of Accessibility to
make the application more usable for the people who are differently abled.

By default, the following accessibility options are provided and there is no need to define
special accessibility preference in the application:

e The application user interface contents are readily accessible for all types of users without
the need to select special accessibility modes.

e The components within the user interface are optimized for use with a screen reader by
default.

e The contents are zoomable by default, eliminating the need for an application large fonts
mode.

e The user interface components auto-detect if operating system (OS) is set to high contrast
mode and automatically render content that is compatible with OS high contrast,
eliminating the need for an application high contrast mode.

Note that, Oracle Financial Services Lending and Leasing application user interface is built on
Oracle Application Development Framework (ADF) and the default accessibility feature
supported by ADF are made available. For additional information, refer to ADF documentation
on accessibility preferences.

1.8.3 Documentation Accessibility Preferences

ORACLE

Apart from assigning the logical sequence and organizing topics, the following techniques are
used to enhance the accessibility of documentation.

e Addition of text equivalent to all graphics

» Usage of standard fonts and avoiding shadow or reversed text

* Usage of strong foreground and background color contrast

e Color usages as per Oracle Accessibility guidelines have been ensured
* Usage of styles and formatting elements

* Documentation in simple language to ensure easy understanding

* Including accurate and effective navigational features, such as cross-reference, tables of
content and bookmarks as appropriate.
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This chapter explains how to use the Wholesale Floor Planning Setup window to set up the
WFP module in Oracle Financial Services Lending and Leasing.

# Note:

Although WFP is a separate module, it uses the Oracle Financial Services Lending
and Leasing system’s seed data, as well as lookup codes defined on the Setup
menu’s Administration form. The Wholesale Floor Planning Setup form only records
setup data specific to the WFP module (just as the Setup menu’s Product module
records data specific to the Loan, Line of Credit, and Lease modules.)

Please do not set up the Wholesale Floor Planning module until after you have completed all
other aspects of Oracle Financial Services Lending and Leasing setup.

e Set up the WFP Lookups

2.1 Set up the WFP Lookups

# Note:

For more information about lookups, see this section of the Lookups link (Lookups
Setup Screen) in the Administration System Setup of this guide

To set up the WFP lookups

1. On the Oracle Financial Services Lending and Leasing home screen, click the Setup
master tab.

2. Click the Administration bar link.

3. Inthe Administration screen’s link bar, click the System drop-down link, then click
Lookups.

4. Inthe Lookups Setup screen’s Lookup Types section, the following lookup codes apply
to the WFP module:

e Set up the WFP Parameters

2.1.1 Set up the WFP Parameters

Following are the WFP parameters that needs to be set up.

ORACLE
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Table 2-1 WFP Parameters
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Lookup Type

Description

WFP_ACCR_BASE_DAYS_CD

BASE DAYS FOR COMPUTING ACCRUALS IN
WFP

WFP_ADJUSTMENT_REASONS_CD

BATCH FILE ADJUSTMENT REASONS

WFP_ADJUSTMENT_TYPES_CD

BATCH UNITS FILE ADJUSTMENT TYPES

WFP_BATCH_STATUS_TYPES_CD

BATCH UNITS FILE STATUS TYPES

WFP_CL_ALTER_ACTIONS_CD

ALTERATION ACTION ON CREDIT LINES IN WFP

WFP_CL_ALTER_REASONS_CD

CREDIT LINE CHANGE REASONS

WFP_CONDITION_REASONS_CD

UNIT CONDITION REASONS

WFP_DELAY_ DAY BASIS_CD

DELAY DAY BASIS

WFP_FEE_CALC_METHODS_CD

FEE CALCULATION METHODS

WFP_GL_HEADER_SEGMENTS

GL HEADER SEGMENTS (SUB CODE USED
FOR LABELS IN GLIS03)

WFP_LEVEL_IND_CD

SUB-TRANSACTION LEVEL INDICATORS

WFP_MONETARY_REASONS_CD

MONETARY TRANSACTION REASONS

WFP_PMT_MODES_CD

PAYMENT MODES OR METHODS

WFP_PMT_REASONS_CD

PAYMENT REASONS

WFP_PMT_STATUS_TYPES_CD

PAYMENT STATUS TYPES

WFP_PMT_TYPES_CD

PAYMENT TYPES

WFP_PRODUCER_STATUS_TYPES_CD

WHOLESALE PRODUCER STATUS

WFP_RATE_REASONS_CD

RATE CHANGE REASONS

WFP_RESCHED_REASONS_CD

UNIT RE-SCHEDULING REASONS

WFP_TXN_ACTION_TYPES_CD

TRANSACTION ACTION TYPES FOR FLOOR
PLANNING

WFP_TXN_BALANCE_TYPE_CD

WHOLESALE FLOOR PLAN WFP WBT BALANCE
CD CODES

WFP_TXN_SUB_TYPES_CD

TRANSACTION SUB TYPES (SUB CODE USED
FOR INDICATING BALANCE)

WFP_TXN_TYPES_CD

FLOOR PLANNING TRANSACTION TYPES

WFP_UNIT_ASSET_TYPE_CD

WHOLESALE FLOOR PLAN ASSET TYPES

WFP_UNIT_COND_ACTION_CD

ACTION ASSOCITED WITH THE WFP UNIT
CONDITION

WFP_UNIT_COND_REASONS_CD

UNIT CONDITION REASONS

WFP_UNIT_COND_TYPES_CD

UNIT CONDITION TYPES

WFP_UNIT_STATUS_REASONS_CD

UNIT STATUS CHANGE REASON

WFP_UNIT_STATUS_TYPES_CD

UNIT STATUS TYPES

WFP_UNIT_TYPES_CD

FLOOR PLAN UNIT TYPES

WFP_WCP_CEIL_INDEX_CD

WHOLESALE FLOOR PLAN WFP WCP CEIL
INDEX CD CODES

WFP_WCP_MARGIN_INDEX_CD

WHOLESALE FLOOR PLAN WFP WCP MARGIN
INDEX CD CODES

WFP_WCP_UNIT_CD

WHOLESALE FLOOR PLAN WFP WCP UNIT CD
CODES

WFP_WFR_FEE_CALC_METHOD_CD

WHOLESALE FLOOR PLAN WFP WFR FEE
CALC METHOD CD CODES

WFP_WIB_LEVEL_IND_CD

WHOLESALE FLOOR PLAN WIB LEVEL
INDICATOR CODES
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Set up the WFP Lookups

The following parameters apply to the WFP module:
«  WFP_MAX_CYCLES_BACKDT
«  WFP_REVERSE_TXN_IND

Wholesale Floor Planning parameters are set up at the system level.
System level parameters

In setting up system level parameters for wholesale floor planning, you will need to know the
answer to the following two questions:

e The number of cycles back dated

*  Which transactions use the reverse indicator?

# Note:

For more information about system level parameters, see this section of Parameters
link (Parameters Setup screen) in the Administration System Setup of this guide.

To set up the WFP parameters at the system level

1. On the Oracle Financial Services Lending and Leasing home screen, click the Setup
master tab.

2. Click the Administration bar link.

3. Inthe Administration Setup link bar, click the System drop-down link, then click
Parameters.

4. Click the Parameters drop-down link, then click System.

5. Onthe System Parameters Setup screen’s System Parameters section, search for and
set up the following parameters:

Parameter:
WFP_MAX_CYCLES_BACKDT
Description:

WFP TRANSACTION NO.OF CYCLES BACKED
Parameter Value:

Type the number of cycles backed.
Parameter:
WFP_REVERSE_TXN_IND
Description:

WFP REVRESAL OF TXN INDICATOR
Parameter Value:

Type the number of cycles backed.
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Index Rates

This section consists of the following topics:

e Introduction

* Index Rate Link

3.1 Introduction

The Index Rates maintains your organization’s history of periodic changes in index rates as it
applies to wholesale floor planning.

It allows you to define the interest rate for the loans extended to the producers by type of credit
line. The index rate provides the base rate for a credit line where:

interest rate = index rate + margin rate.

An index type can have different rates depending on the start date. For each index type, the
Index Rates section records the interest rate and the start date after which the rate is
applicable. If you do not want to use a variable index rate, you can use the flat rate index.

3.2 Index Rate Link

ORACLE

While you can add new rates for an existing index type, you cannot modify or delete existing
index rates.

To use the Index Rates link
On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
WFP > Index Rates

1. Inthe Index Types section, select the record you want to work with. Note: PRIME RATE
and FLAT RATE are the default, system defined rate types.
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Figure 3-1 Index Rates
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Note the Following:
If you choose, use Search Criteria to limit the display of records.

* If you are entering a new record, click Add.
» If you are changing an existing record, click Edit.

2. Inthe Index Types section, enter, view, or edit the following information.

Table 3-1 Index Types
|

In this field Do this

Index Type Select the index type (required).

Short Description Enter the short description of the index rate type
(required).

Description Enter the longer description of the index rate
type (required).

Enabled Select to enable the index rate type.

3. Inthe Index Rates section, select the record you want to work with.
Note the following:
* If you choose, use Search Criteria to limit the display of index rates records.
* If you are entering a new record, click Add.

4. In the Index Rates section, enter the following information.

Table 3-2 Index Rates

'
In this field Do this

Start Date Enter the start date of the index rate. Note: This
cannot be less than current date (required).

ORACLE -



ORACLE

Chapter 3
Index Rate Link

Table 3-2 (Cont.) Index Rates

|
In this field Do this

Rates Enter the rate. Note: For a particular index type,
multiple rates cannot be entered in the Index
Rates section with the same start date
(required).

Enabled Select to enable the index rate.

Click Save in the Index Types section.

For example,
Using the data in the sample graphic, let's assume the current date is February 5, 2009
(10/ 30/2008).

The entries in the Index Rates section for a PRIME RATE include:

Table 3-3 Index Rates section for a PRIME RATE

Start Date Rate
01/29/2009 3.0
10/16/2008 12.0
10/03/2008 8.0

In this scenario 8.0% will be the rate used by Oracle Financial Services Lending and
Leasing to compute interest on October 10, 2008.
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Fees

This section consists of the following topics:

e Introduction

 Fees Link

4.1 Introduction

The Fees link allows you to define the method of computing the various producer, credit line,
and unit level fees. You can define different fee calculations for a state, producer, and credit

line.

< Note:

The Fee Rules section on the Fees link displays all the system defined balance
types, even those disabled on the Balance Types screen. This is necessary for
Oracle Financial Services Lending and Leasing to retain the fee rules associated with
the balance type in case any are already associated with any existing units.

4.2 Fees Link

To use the Fees link

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
WFP > Fees.
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Figure 4-1 Fees
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1. Inthe Fee Balances Types section, select the record you want to work with.

# Note:

If you choose, use Search Criteria to limit the display of instrument records.

2. Inthe Fee Balances Types section, view the following information:

Table 4-1 Fee Balances Types

___________________________________________________________________________|
In this field View this
Fee The system defined fee types applicable for WFP
(display only).
Description The balance description of the fee type (display
only).

Level View the balance type level at which a fee is
applicable: PRODUCER, CREDITLINE, or UNIT
(display only).

3. Inthe Fee Rules section, select the record you want to work and click Show in the Details
column.

Note the following:
If you choose, use Search Criteria to limit the display of the fee rule records.

e If you are entering a new record, click Add.
e If you are changing an existing record, click Edit.

4. Inthe Fee Rules section, enter, view, or edit the following information:
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Chapter 4
Fees Link

In this field Do this

State Select state initials (required).

Producer #: Name Select the producer (optional).

Credit Line Select the credit line (optional).

Start Date Start the date from when the fee rule is
applicable (required).

End Date Start the date till which the fee rule is applicable.
A blank field indicates no end date (optional).

Enabled Select to enable this fee rule.

Calculation Method

Select the calculation method. If the calculation
method is FLAT, then Fee% field should have the
value 0.0 and the Fee Amount - Maximum field
would have the same value as that in the Fee
Amount - Minimum field. Oracle Financial
Services Lending and Leasing uses the Fee
Amount - Minimum field for fee calculation
(required).

Fee%

Enter the fee percentage (required).

Fee Amount Minimum

Enter the minimum fee amount that would be
charged to the producer (required).

Fee Amount Maximum

Enter the maximum fee amount that would be
charged to the producer (required).

5. Click Save on the Fee Balance Types section.

Table 4-3 Fees and calculation method

Description Level Calculation Methods
supported

NON SUFFICIENT FEES PRODUCER FLAT

PRODUCER ANNUAL FEES PRODUCER FLAT

CREDIT LINE AUDIT FEES CREDIT LINE FLAT

LATE CHARGE UNIT FLAT
PERCENTAGE OF PAYMENT
DUE
PERCENTAGE OF BALANCE
PAYMENT
UNIT CHARGE

UNIT SERVICE FEES UNIT FLAT

UNIT OTHER FEES UNIT FLAT

ORACLE
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Pricings

This section consists of the following topics:

e Introduction

e Pricing Link

5.1 Introduction

The Pricing link records the various pricing plans the financial institution offers to its producers.
By default, sample pricing plans are available while setting up WFP. You can then modify and
add plans to this screen. At least one pricing plan should be enabled.

5.2 Pricing Link

ORACLE

Oracle Financial Services Lending and Leasing takes the index rate from the Index Rates
screen for the code in the Margin Index field and adds the value of the Margin Rate to calculate
the credit line’s interest rate.

You cannot define different pricing policies for different producers (since producer is not a part
of Policies setup). However, it is possible to overcome this by having two different credit lines
on the Pricing screen, NEW-PRODUCER A and NEW-PRODUCER B, with the same unit type
NEW.

To use the Pricing link

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
WFP > Pricings.

Figure 5-1 Pricing
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In the Pricing Details section, select the record you want to work with and click Show in the

Details column.

If you choose, use Search Criteria to limit the display of records.

e If you are entering a new record, click Add.

< If you are changing an existing record, click Edit.

1. Inthe Pricing Details section, enter, view, or edit the following information:

Table 5-1 Pricing Details

In this field

Do this

Code

Enter the pricing code (required).

Credit Line

Enter the credit line. Each entry in the list should
be unique (required).

Description

Enter a description of the credit line (required).

Unit

Select the unit type. This describes the type of
unit to which the pricing applies (required).

Start Date

Enter the start date. This is the date after which
the pricing plan would be in use and available in
maintenance. Note: The start date of a pricing
plan cannot be less than the current date
(required).

End Date

Enter the end date. This is the date after which
the pricing plan would not be available. Note:
The end date cannot be less than the current
date or start date (optional).

Enabled

Select to enable the pricing policy.

Initial Adv%

Enter the initial advance percent. This indicates
what percent of the value of the unit is given to
the producer as an advance (loan). For example,
if the value of a new vehicle is $10,000 and the
loan given to the producer is $8,000 then the
initial advance percent is 80 percent (optional).

Term

Enter the total term in months. This indicates the
maximum term (in months) of the credit line
(optional).

Current Yr Curtailment

Enter the percent of outstanding principal which
need tobe recovered from the producer each
month in the current year.

Prior Year Curtailment

Enter the prior year curtailment percent
(optional).

Margin Rate

Enter the margin rate. The interest rate equals
the index rate plus margin rate. Index rate is the
applicable interest rate for the selected index
type (optional).

Ceiling Index

Select the ceiling index code. This indicates the
index on which the interest rate ceiling would be
based (optional).

ORACLE
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Table 5-1 (Cont.) Pricing Details

Chapter 5
Pricing Link

In this field

Do this

Ceiling Rate

Enter the ceiling margin rate. This defines the
ceiling for interest. The ceiling rate equals the
ceiling index rate plus the ceiling margin rate. For
example, if the index rate is three percent, the
margin rate is one and a half percent, and the
ceiling rate is five percent, then the interest rate
is four and a half percent. If the index rate
increases to four percent, the interest rate will be
five percent and not five and a half percent
(optional).

Click Save in the Pricing Details section.
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Contracts

This section consists of the following topics:

e Introduction

e Contracts Link

6.1 Introduction

The Contract link allows you to define the terms and conditions of your contracts. Contracts
can be defined according to company, branch, and type of unit. You can add new contracts and
modify the existing ones.

6.2 Contracts Link

Oracle Financial Services Lending and Leasing selects which instrument to offer based on

whether:

e The instrument company/ branch matches the producer company/ branch. Note: We
recommend setting up an instrument where the company / branch is ALL/ ALL to ensure
proper performance in Oracle Financial Services Lending and Leasing

¢ The contract date at unit level should be between the instrument start and end date

¢ The instrument is enabled.

To use the Contract link

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
WFP > Contracts.

Figure 6-1 Contract
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In the Instrument section, select the record you want to work with and click Show in the
Details column.

If you choose, use Search Criteria to limit the display of records.

1.

If you are entering a new record, click Add.

If you are changing an existing record, click Edit.

In the Instrument section, enter, view, or edit the following information:

Table 6-1 Instrument section

In this field

Do this

Name

Enter the uniqgue name of the instrument
(required).

Description

Enter the instrument description. This entry
should briefly describe the instrument (required).

Company

Select the company for which the instrument is
applicable (required).

Branch

Select the branch of the company for which the
instrument is applicable (optional).

Start Date

Enter the start date. This is the date after which
the instrument is in use and is available on the
Wholesale Floor Planning Maintenance form
(required).

End Date

Enter the end date after which the instrument is
invalid and unavailable on the Wholesale Floor
Planning Maintenance form. While this field can
be empty, it cannot be less than the current date
or start date (required).

A blank field indicates no end date (optional).

Enabled

Select to enable the contract instrument.

Unit

Select the unit type (required).

This field links the policies to contracts. There
should be at least one enabled contract for every
unique unit type (required).

Start Basis

Select the accrual start date basis. This indicates
the date from which the interest rate would be
calculated. For example, a start basis that equals
the payment date implies that the interest rate
calculation starts with the first payment date
(required).

Payment Tolerance Amount

Enter the payment tolerance amount. This
defines the acceptable shortfall in the monthly
payment in dollars for which no penalty would be
imposed (required).

Writeoff Tolerance Amount

Enter the writeoff tolerance amount. This is the
tolerance acceptable while a unit gets paid off.
The unit will be considered paid even if payment
is falling short of actual due by this amount
(required).

Pmt Tolerance%

Enter the payment tolerance percent. This
defines the acceptable percent of the monthly
payment due which no penalty would be
imposed. For example, the tolerance can be set
for 95 percent of payment due (required).
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In this field

Do this

Late Charge Grace days

Enter the late charge grace days. This is the
number of days after the payment due date
during which no late fee would be charged
(required).

# Rate Changes/ Year

Enter the number of rate changes in a year. This
is the maximum number of times the rate can be
changed in a year for a unit. Note: The number
of rate changes in a year cannot exceed the
number of rate changes for the life of the contact
(required).

Max Rate Increase Year

Enter the maximum rate increase in a year. This
is the ceiling limit for rate increases in a year
(required).

Max Rate Decrease Year

Enter the maximum rate decrease in a year. This
is the floor limit for rate decreases in a year
(required).

Accrual Base Days

Select the accrual base days. This is the number
of days the instrument assumes in a year for
interest computation: 360, 365, or 366. If the
accrual base is selected as 365, the interest
computation would be based on actual days
(365) and the base would be 365. However, in
this case, if the year happens to be a leap year
and the actual day’s computation includes the
month of February, then the additional day of
leap year is not considered (required).

Accrual Start Days

Enter the accrual start days. This is the number
of days after which interest accrual starts once
the instrument is in use (required).

Refund Tolerance Amount

Enter the refund tolerance amount. If the refund
due to the producer is more than this, the
tolerance amount is refunded. Note: You cannot
complete this field if the Refund Allowed box is
selected (required).

Dlg Grace Days

Enter the delinquency grace days. This is the
number of days after the payment due date
during which the account will not be considered
delinquent (required).

# Rate Change Life

Enter the number or rate changes in life. This is
the maximum number of times the rate can be
changed during the life of the contract (required).

Max Rate Increase Life

Enter the maximum rate increase in life of loan.
This is the ceiling limit for rate increase during
the entire life of the contract (required).

Max Rate Decrease Life

Enter the maximum rate decrease in life. This is
the floor limit for rate decrease during the entire
life of the contract (required).

Refund Allowed

If selected, this check box indicates this
instrument allows a refund in case the producer
pays in excess of what is due (required).

The Instrument Balance Types section allows you to define the balance type for the
selected instrument at the producer, credit line, or unit level.
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In the Instrument Balance Types section, select the record you want to work with.
« If you choose, use Search Criteria to limit the display of records.

— If you are entering a new record, click Add.

— If you are changing an existing record, click Edit.

In the Instrument Balance Types section, enter, view, or edit the following information:

Table 6-2 Instrument Balance Types
|

In this field Do this

Select If selected, indicates that this is the current
record.

Balance Type Select the balance type (required).

Level View the level indicator. This entry is based on
the selected Balance Type and is non-editable
(required).

Include Monthly Due ? Select to compute the minimum monthly
payment.

4. Click Save in the Instrument section.
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Balances

This section consists of the following topics:

e Introduction

« Balances Link

7.1 Introduction

The Balance Types link displays the various types of balance types computed for each
producer (or dealer) set up in the WFP module. The balances defined in the Balance Types
section are fixed, system defined, and set up during WFP installation. You cannot add or
modify any balance types. However, you can choose not to use a balance type by clearing its
Enabled check box.

7.2 Balances Link

To view the Balance Types link

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
WFP > Balances.

1. Inthe Balance Types section, select the record you want to work with.

Figure 7-1 Balance Types
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2. Inthe Balance Types section, view the following display only information:

Table 7-1 Balance Types

In this field View this

Type The transaction type.

Code The balance code.

Description The description.

Level The balance level. This indicates whether the
balance is computed at PRODUCER, CREDIT
LINE, or UNIT level.

Enabled Select to enable the balance types. When this
check box is clear, Oracle Financial Services
Lending and Leasing will not compute this
balance from that date on for all new producers,
credit lines, or units.

# Note:

The balance types PRINCIPAL BALANCE and INTEREST should be enabled at

the UNIT level.
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Transactions

This section consists of the following topics:

e Introduction

*  Transaction Codes Link

8.1 Introduction

The Transactions records the system defined, consolidated list of transaction codes available
in the WFP module.

The transaction codes defined on this screen are fixed, system defined, and set up during
WEFP installation; you cannot modify them. However, you can choose not to use a transaction
code by clearing its Enabled check box. You can also choose which transactions affect the
general ledger by selecting the GL check box.

The transaction codes defined here are available on the Wholesale Floor Planning
Maintenance form.

# Note:

If any transaction code is disabled on the Transaction Codes screen, it may have an
impact on the spreads if the disabled transaction code was listed in the Spread
Details section on the Spreads screen. Oracle Financial Services Lending and
Leasing would not be able to prevent allocation of payment to this code in spite of it
being disabled.

8.2 Transaction Codes Link

To use the Transaction Codes link

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
WFP > Transactions.
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Figure 8-1 Transaction Codes
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1. Inthe Transaction Codes section, select the record you want to work with.
If you choose, use Search Criteria to limit the display of records.

* If you are entering a new record, click Add.
» If you are changing an existing record, click Edit.

2. Inthe Transaction Codes section, enter, view, or edit the following information.

Table 8-1 Transaction Codes

'
In this field Do this

Code Enter transaction type code. This is a system
defined code for the transactions. The first letter
of the code indicates the type of task the
transaction performs:

P — payment

F —fee

O — charge off

Q —reverse charge off

R —reverse

W — waive

V — reversal of waived transaction (required).

Description Enter the description associated with the
Transaction code. This is a system defined field
that can be modified by users (required).

Type Select the transaction type. This field maps the
transaction code to into Transaction types
(required).

Sub Type Select the sub type (required).

ORACLE -
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Table 8-1 (Cont.) Transaction Codes

|
In this field Do this

Action Select the action type. For more information
about the Action field, see the following section,

A Note about the Action Field. Note: If a
transaction code has an action of POST, WAIVE,
or CHARGEOFF, then a REVERSE action
should also be associated with this code
(required).

Manual Select to allow users to post these transactions
on the Wholesale Floor Planning Maintenance
form.

GL Select to post the transaction to the general
ledger when performed.

Enabled Select to enable the transaction code.

Note: Transactions codes which are not selected
are not available in the LOVs on the WFP
maintenance screens.

# Note:

Transaction codes of transaction type INTEREST and PRINCIPAL cannot have a
cleared Enabled check box.

Click Save in the Transaction Codes section.

A Note about the Action Field

The Action field indicates how the transaction code affects the account. The standard actions
associated with the various transaction codes are as follows:

POST
BILLING
CHARGE-OFF
WAIVED
REVERSE
VOID

Most Type field and Sub Type field combinations have an action and a reverse action
associated with them. Each Type field, Sub Type field, and Action field combination is identified
using a unigue transaction code.

For example,

The Type FEE and Sub Type PRODUCER ANNUAL FEES combination has the eight
following actions associated with it, each having a unique transaction code:

Note that there are four actions and four reverse actions associated with the Annual Fee.

ORACLE
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Table 8-2 Transaction code - Type and Sub Type combinations
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Transaction Codes Link

Code Description Type Sub Type Action
FAANL Annual Fee Fee Producer Annual Post
Fees
RFAANL Reversed - Annual Fee Producer Annual Reverse
Fee Fees
FBANL Annual Fee - Billing Fee Producer Annual Billed
Fees
RFBANL Reversed - Annual Fee Producer Annual Reverse
Fee Billing Fees
OFAANL Annual Fee - Fee Producer Annual Chargeoff
Chargeoff Fees
QFAANL Reversed - Annual Fee Producer Annual Reverse
Fee Chargeoff Fees
WFAANL Annual Fee - Fee Producer Annual Waived
Waived Fees
VFAANL Reversed - Annual Fee Producer Annual Reverse
Fee Waived Fees

Most of the Type and Sub Type combinations would have these eight transaction codes.
However, there are some transactions such as Payment, Rate Change, Rescheduling Unit,
Void, and Status Change which may not have all eight codes.

Details of the transaction codes would be listed in the seed data.
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Spreads

This section consists of the following topics:

e Introduction

e Spreads Link

9.1 Introduction

The Spreads link records the order in which Oracle Financial Services Lending and Leasing
allocates a payment spread for a spread transaction code. You can add to or disable the seed
data sample spreads on this screen as you choose. However, you must verify that there is no
residual dollar amount, as Oracle Financial Services Lending and Leasing refunds the
producer any balance not used in the spread.

9.2 Spreads Link

Spread details uses the transaction codes listed in the transaction codes setup. In case any of
the transaction codes are disabled from transaction codes setup, Oracle Financial Services
Lending and Leasing would not remove that code from spread details. You must manually
verify that such codes are removed from the spread details as well.

To use the Spreads link

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
WFP > Spreads.

Figure 9-1 Spreads
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1. Inthe Spread Codes section, select the record you want to work with.

If you choose, use Search Criteria to limit the display of spread code records.

ORACLE
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* If you are entering a new record, click Add.
» If you are changing an existing record, click Edit.

2. Inthe Spread Codes section, enter, view, or edit the following information:

Table 9-1 Spread Codes
|

In this field Do this

Code Enter an unique code for the spread (required).

Description Enter a description for the spread code
(required).

Level Select the indicator to define the level at which

the fee is applicable.

Note: While making changes on the Spreads
screen, make sure that there is one and only one
enabled spread code for each level (required).

Default Select to indicate this a default spread code.
Enabled Select to enable this spread code.

The Spread Details section records the details of the transaction codes to which Oracle
Financial Services Lending and Leasing applies the spread, as well as the priority for
applying the spread over multiple transactions. At least one enabled transaction code
should be available for each spread.

3. Inthe Spread Details section, select the record you want to work with.
* If you choose, use Search Criteria to limit the display of spread details records.
— If you are entering a new record, click Add.
— If you are changing an existing record, click Edit.

4. Inthe Spread Details section, enter, view, or edit the following information:

Table 9-2 Spread Detail
|

In this field Do this
Txn Code Select the transaction code (required).
Description View the transaction code description as set up

on the Setup master tab’s Transaction Code
screen (display only).

Seq Enter the sequence in which the spread would
be applied to various Txn codes (required).
Enabled Select to enable the this spread detail.

5. Click Save on the Spread Codes section.
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Appendix : Late Fee Methods Definitions

ORACLE

FLAT AMOUNT
FLAT AMOUNT charges a flat (fixed amount) fee when an account becomes overdue.

For example, if the FLAT AMOUNT late fee is set at $25, and the account is $900 overdue,
then the late fee assessed will be $25. For each month the account is overdue, regardless of
the amount, the late fee assessed will be $25.

PERCENTAGE OF PAYMENT DUE

PERCENT OF PAYMENT DUE charges a late fee based on a percentage of the part of a
payment due that remains to be paid.

For example, if the PERCENT OF PAYMENT DUE late fee is set as 10%, and if only $90 of
a $200 standard payment is due, then the late fee will be $9 (10% of 90).

If $3000 on a loan with a standard payment of $200 is due, the late fee will be $20 (10% of
200). This is because the computed late fee is based only on the payment due for that month --
not the accumulated due amount.

If the stated monthly payment is $300 and account is delinquent for 3 months ($900), then
every month the late fee is computed only on the amount due for that month ($300 or part
of $300) -- not on $900.

PERCENTAGE OF STANDARD PAYMENT

PERCENTAGE OF STANDARD PAYMENT charges a late fee based on the standard monthly
payment, regardless of the current amount due.

For example, if you set 10% as the PERCENTAGE OF STANDARD PAYMENT late fee, the
standard payment amount was $500, and the account was due for $2000, then the late fee will
be $50 (10% of 500). In other words, every month the system computes the late fee using
monthly standard payment amount ($500), irrespective of the amount paid by the customer.

If the customer pays $400 out of $500, the system still computes the late fee using $500, and
not on $100.

FLAT AMOUNT PYRAMID LAW

FLAT AMOUNT PYRAMID LAW prevents the pyramiding of flat late fees. If an account is
overdue, then the system assesses a flat (fixed amount) late fee. However, if the standard
payment is made the following month, then a new late charge will not be created, even if the
payment made does not fulfill the current amount due.

For example, if a customer is assessed a late fee of $25 for 1/2005, and makes his $200
standard payment in 2/2005, that person cannot be assessed a new $25 late fee for 2/2005
(even though his payment only fulfilled the amount owed for 1/2005).

If a customer makes a payment of just $199 in 1/2005 (an amount that does not fulfill the
standard payment), then the customer could also be assessed a $25 late fee for 2/2005.

If the customer makes a payment of $199 in 2/2005 (an amount that does not fulfill the
standard payment), then the customer could be assessed a late fee for 2/2005.
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PERCENTAGE OF PAYMENT DUE PYRAMID LAW

PERCENTAGE OF PAYMENT DUE PYRAMID LAW prevents the pyramiding of percentage of
payment due late fees. If an account is overdue, then the system assesses a fee based on
what part of a payment remains to be paid. However, if the standard payment is made the
following month, then the system will not create a new late charge, even if the payment made
does not fulfill the current amount due.

For example, if the PERCENTAGE OF PAYMENT DUE PYRAMID LAW late fee is set as 10%,
and if only $90 of a $200 standard payment was due, then the late fee would be $9.

If $3000 on a with a standard payment of $200 was due, the late fee would be $20. However, if
a customer was assessed a late fee of $9 for 1/2005, and makes his $200 standard payment in
2/2005, then that person cannot be assessed a new late fee for 2/2005 (even though his
payment only fulfilled the amount owed for 1/2005).

If the customer makes a payment of $199 in 2/2005 (an amount that does not fulfill the
standard payment), then the individual could be assessed a late fee for 2/2005.

# Note:

The system computes the late fee based on the payment due for only that month and
not the accumulated due amounts.

If the stated monthly payment is $300 and account is delinquent for 3 months ($900), then the
system computes the late fee every month with the amount due for that month ($300 or part
of $300) and not on $900.

PERCENTAGE OF STANDARD PAYMENT PYRAMID LAW

PERCENTAGE OF STANDARD PAYMENT PYRAMID LAW late fee prevents the pyramiding of
percentage of standard payment late fees. If an account becomes overdue, then the system
assesses a fee based on the standard monthly payment, regardless of the current amount due.
However, if the standard payment is made the following month, then the system will not create
a new late charge, even if the payment made does not fulfill the current amount due.

For example, if the PERCENTAGE OF STANDARD PAYMENT PYRAMID LAW late fee is set
as 10%, and the standard payment is $200, then $20 (10% of 200) is owed. If only $90 of
a $200 standard payment was due, then the late fee would still be $20.

If $3000 on a with a standard payment of $200 is due, the late fee will be $20, since the fee is
calculated based on the payment due -- not the total outstanding amount due.

However, if a customer is assessed a late fee of $20 for 1/2005, and makes the $200 standard
payment in 2/2005, that person cannot be assessed a new late fee for 2/2005, even though the
payment only fulfills the amount owed for 1/2005. If the customer makes a payment of $199 in

2/2005 (an amount that does not fulfill the standard payment), then the system could assess a

late fee for 2/2005.
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Appendix : Rounding Amounts and Rate
Attributes

Rounding Amounts

Generally in the lending industry, computed amounts (interest, fees, costs and so on) are
rounded to the second decimal place. However, there are occasions where the rounding of the
computed amounts has to be carried out using different methods. Oracle Financial Services
Lending and Leasing supports the rounding, raising of or cutting off calculated amount.

* Rounding will increase the resulting amount to next number up to the second decimal,
based on values of third decimal.

* Raising will always increase the resulting amount to next number up to the second
decimal.

e Cutting off will always cut the number after the second decimal.

# Note:

The system rounds only calculated amounts (calculated fees, calculated payment,
and so on) and not user-entered amounts.

You can choose the rounding method you want to use by setting the parameter value for
system parameter CMN_AMOUNT_ROUND_METHOD on the Administration form (Setup
menu > Administration master tab > System drop-down link > System Parameters link >
System tab).

You can choose the rounding factor you want to use by setting the parameter value for system
parameter CMN_AMOUNT_ROUND_FACTOR on the Administration form. Currently, Oracle
Financial Services Lending and Leasing supports rounding up to two decimals only.

Examples of how resulting amounts differ by RAISE, ROUND, and CUTOFF:

Table B-1 Example 1: Amount: 234.136
]

Method Result
Round 234.14
Raise 234.14
Cut off 234.13

Table B-2 Example 2: Amount: 234.134
]

Method Result
Round 234.13
Raise 234.14
Cut off 234.13
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Table B-3 Example 3: Amount: 234.1319999

Method Result
Round 234.13
Raise 234.14
Cut off 234.13

Rate Attributes

The system supports rounding of index rate to keep the rate calculation as simple as possible
for the customers. The general practice is to round the rate to nearest eighth (1/8th) (to keep
index rate in the multiple of 125) or fourth (1/4th) (to keep index rate in the multiple of 25). The
system rounds only index rate and not the margin or final rate. You can define the index
rounding method on the Product tab’s Product Definition screen for variable rate product.

The system currently supports the following rounding of methods.
1. NO ROUNDING TO INDEX RATE

2. INDEX RATE ROUNDED TO NEAREST.25

3. INDEX RATE ROUNDED TO NEAREST.125

NO ROUNDING TO INDEX RATE:

Select this method for no rounding.

INDEX RATE ROUNDED TO NEAREST 0.25:

Select this method to round up to 1/4th (to keep the index rate in the multiple of 0.25).

Examples:

Table B-4 Example 1

Type Value
Current rate: 5.125
Round of rate: 5.25

Table B-5 Example 2

Type Value
Current rate: 5.124
Round of rate: 5.00

INDEX RATE ROUNDED TO NEAREST 0.125:
Select this method to round up to 1/8th (to keep the index rate in the multiple of 0.125).

Examples:

Table B-6 Example 1

|
Type Value

Current rate: 5.325
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Table B-6 (Cont.) Example 1

_________________________________________________________________________________|
Type Value

Rate rounded to: 5.375

Table B-7 Example 2
]

Type Value
Current rate: 5.312
Rate rounded to: 5.250
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Appendix : System Parameters

This topic consists of the following sections:

e Introduction

e System Parameters

e Organization Parameters
¢ Company Parameters

e Other Parameters

C.1 Introduction

System defined parameters help in configuring system specific data, User-access, location of
system files; reports related URLs and other administration controlled data. These are
essential to be configured during installation and some of them by nature of application will
have to be reviewed and maintained in a regular and periodic manner.

Following are the types of parameters are used in OFSLL system depending on the areas of
the system that these would apply and impact:

e System Parameters
e Organization Parameters
e Company Parameters

e Other Parameters

# Note:

All the above parameters can be controlled (enabled/disabled) only by System
Administrators, and users with Admin/Super User privileges who would be involved in
setting-up OFSLL system.

C.2 System Parameters

ORACLE

System parameters apply to the entire system. They relate to the overall processing of the
system like application server file locations, data purging configurations and so on.

Table below details the list of system parameters with their description and pre-defined values.

Table C-1 System Parameters

______________________________________________________________________________|]
Parameter Description

ACA_DLQ_AMT_EXCLUDED This parameter is used to exclude delinquency
amount for account ACH
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Parameter

Description

ACA_PAYMENT_AUTO_ LOAD

This parameter is used to control posting directly
from the ACH file that has been created for
customer payments. Input parameter value is
Boolean (Yes/No). If the parameter is setto Y, the
system automatically creates payment batches for
the payments in the ACH file and posts them on the
day of payment.

ACA_PRENOTE_DAYS

This parameter is used to define the number of
days the prenote should be initiated for customer
ACH (Automated Clearing House) accounts. Input
parameter value is numeric.

ACA_PRE_PROCESS_DAYS

This parameter is used to specify the number of
days before draft day for Account ACH process.
Input parameter value is numeric.

ACH_PAYEE_PRENOTE_DAYS

This parameter is used to define the number of
days for prenote to occur for Producer or Vendor
ACH accounts. Input parameter value is numeric.

ADMIN_SERVER_URL

This parameter is used to define the admin server
URL.

ADR_DIRECTORY

This parameter is used to define the Oracle
Directory Object Name for ADR file location.

ADR_PROCESSED_DIRECTORY

This parameter is used to define the Oracle
Directory Object Name for ADR file location.

AGE_APPROVED_CONDITIONED_ DAYS

This parameter is used to specify the number of
days by which an application in Approved or
Conditioned status is treated as Aged Application.
Input parameter value is numeric with no upper
limit.

AGE_CONTRACT_DAYS

This parameter is used to specify the number of
days by which a contract is treated as Aged
Contract. Input parameter value is numeric with no
upper limit.

ASC_COL_SER_ENABLED_ IND

This parameter is used as the Collection Servicing
Enabled Indicator.

CAC_DIRECTORY

This parameter is used to define the Oracle
Directory Object Name for CAC file location.

CAC_PROCESSED_DIRECTORY

This parameter is used to define the Oracle
Directory Object Name for CAC file location.

CHECK_PRINT_PREVIEW

Using this parameter we can allow preview of
application in pdf form before printing. Input
parameter value is Boolean (Yes/No).

CMN_AMOUNT_ROUND_ FACTOR

This parameter is used to define the rounding
factor for applicable fields (in this case calculated
amounts). Input parameter value is ROUND
AMOUNT TO 2 DECIMALS. Currently system
supports rounding factor 2 only.
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Table C-1 (Cont.) System Parameters

_________________________________________________________________________________|
Parameter Description

CMN_AMOUNT_ROUND_METHOD This parameter is used to define the amount round
method during system set-up and would be
applicable for all calculated amounts (calculated
fees, payment etc.) across the application. Input
values are ROUND, RAISE and CUTOFF:

ROUND: Rounded to nearest humber higher or
lower

RAISE: Rounded to the nearest higher number

CUTOFF: Truncate the digits without rounding or
raising

CMN_APP_ACC TITLE_FN_LN This parameter is used to set the Application or
Account title in one of the formats — First/Last
Name or Last/First Name. Input parameter value is
Boolean (Yes/No). If Yes is chosen, title would be in
the format — First/Last Name, else the other option.

CMN_APP_SERVER_HOME This parameter is used to set the Application
Server Home Directory. Input parameter value is
user defined.

CMN_CURRENT_MODEL_YEAR This parameter is used to default the Current Model
Year.

CMN_DEBUG_LEVEL This is the Common Debug Level

CMN_DEBUG_METHOD This parameter allows to define the location to

which generic debug logs (other than Alert/Warning
and GRI) are to be written. If set to
ADVANCE_QUEUE, system writes the logs in
Logs table and if set to UTL_FILE, system
generates the alert log file.

CMN_FILE_PROCESS_TO_LOB This parameter allows to define the location from
where the incoming or outgoing files/documents
are to be processed. If set to Y, system processes
the data to/from LOB and if set to N, system
processes the data to/from FILE.

The same is used by the batch jobs available in
SET-IFP (input file processing) Batch Job Set.

CMN_GL_POST_DT This parameter is used to specify the General
Ledger Posting date. If scheduler is enabled, it
automatically updates this to current system date.
Else Admin User would need to set this date
manually to ensure correct posting dates in GL.

CMN_HTTP_PROXY_ PORT This parameter is enabled to specify the port to be
used for outgoing HTTP connections. Input
parameter value is user defined.

CMN_HTTP_PROXY_SERVER This parameter is enabled to specify the proxy
server to be used for outgoing HTTP connections.
Input parameter value is user defined. There exists
an interdependency of this parameter with
CMN_HTTP_PROXY_PORT mentioned above.
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Parameter

Description

CMN_INT_360_ACCRUAL_DAYS_MTHD

This parameter is used to specify the interest
accrual method for 360 days, to be used by the
System for all calculations with interest. Currently
two methods are supported. Input parameter value
is US or EU representing American and European
method of interest accrual for 360 days.

CMN_TEST_TOOL_LOGGING

This parameter is used to set testing tool logging
parameter

CMN_SCHEMA _ID

This is used to specify the schema identifier for all
users.

CMN_SCHEMA_NAME

This is used to specify the Oracle User Name for a
specific schema. Input parameter value is user
defined.

CMN_SCHEMA_PASSWORD

This captures the password for Oracle, for the
specific schema. Input parameter value is user
defined. This parameter need not be enabled when
in Oracle Network.

CMN_SERVER_HOME

This parameter captures the Server Home
Directory. Input parameter value is user defined.

CMN_SERVER_TEMP_DIR

This parameter is used to specify the temporary
directory on the server along with the path. Input
parameter value is user defined.

CMN_SER_ENVIRONMENT_ FILE

This parameter captures the environment file (and
its path) for running the Operating System
commands from Job Service. Input parameter
value is user defined.

CMN_WALLET_PASSWORD

This parameter is used to specify the common
wallet password. Input parameter value is user
defined.

CMN_WALLET_PATH

This parameter is used to specify the common
wallet path for oracle database. Input parameter
value is user defined.

CPP_NO_OF_PROMISES

This parameter is used to define the maximum
number of promises/chances allowed for a
customer who is delinquent and promises to pay.
Input parameter value is numeric with no upper
limit.

CPP_PROMISE_HELD_DAYS

This parameter is used to define the maximum
number of days after the promises made by the
customer to pay are broken to initiate further
actions. Input parameter value is numeric with no
upper limit.

CRD_CHS_BIN

This parameter holds the value of the credit card
BIN (Bank Identification Number for Credit Cards),
for CHASE interface. Input parameter value is user
defined. (P.S: OFSLL supports CHASE interface for
credit card payments processing)

CRD_CHS_CUR_CODE

This parameter is used to specify the currency
code of the transacting currency for CHASE
interface. Input parameter value is user defined.
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Parameter

Description

CRD_CHS_DIR_PATH

This parameter is used to specify the directory path
for CHASE payment interface for Credit Cards.
Input parameter value is user defined.

CRD_CHS_IND_TYPE

This is used to specify the industry type for CHASE
payment interface for Credit Cards. Input parameter
value is user defined.

CRD_CHS_MERCHANT_ ID

This captures the merchant ID number for CHASE
payment interface for Credit Cards. Input parameter
value is user defined.

CRD_CHS_REMOTE_HOST_NAME

This captures the remote host name for seeking
approvals for CHASE payment interface. Input
parameter value is user defined.

CRD_CHS_SEC_REMOTE_HOST_NAME

Similar to the previous parameter this captures the
secondary remote host name of CHASE interface
for seeking approvals for credit card payments.
Input parameter value is user defined.

CRD_CHS_TIMEOUT

This parameter is used to define the timeout limit
when polling the interface for processing credit card
payments. Input parameter value is numeric.

CRD_CHS_USR_ID

This parameter captures the user id for CHASE
interface which is required whenever the System
needs to access/ seek authorizations/process
payments for credit cards etc. Input parameter
value is user defined.

CRD_PTB_REMOTE_HOST_NAME

This is the Protobase Remote Host Name

CRD_PTB_REMOTE_HOST_PORT

This is the Protobase Remote Host Port

CRD_PTB_TIMEOUT

This is the Protobase Timeout Value

CRD_SOURCE_TYPE_CD

This is the Source Type Code

DDT_CREATE_DUE_ DATE_HISTORY

This parameter must be enabled to create a due
date history for any account. Due date history sub
tab under Transaction history displays the
delinquency history of an account in a tabular
format detailing Due date, Due Amount, Last
Payment date, Payment Amount, Balance Amount,
Days past due and Payment received flag. The
input parameter value for this parameter is Boolean
(Yes/ No).

DECISION_ BUY_RATE_TOLERANCE

This parameter is used to define the variance in
buy rate

EDF_DIALER_ACCT_TYPE

This parameter is used to set up the account
number reference for the dialer file to pick-up
records for Auto dialer interface. Input parameter
value is account number.

FLL_BPEL_PROCESS

This parameter is set to use BPEL process in
OFSLL. Input parameter value is Boolean (Yes/No).

ICA_INPUT_FILE_FORMAT

This parameter is used to define the input call
activity file format

IFD_DIRECTORY

This parameter is used to define the Oracle
directory object name for IFD file location

IFD_PROCESSED_DIRECTORY

This parameter is used to define the Oracle
directory object name for IFD file location
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Parameter

Description

INCOMING_ LOB_PURGE_DAYS

This parameter is used to define the incoming
process file table purge days

INPUT_DIRECTORY

This parameter is used to define the Oracle
directory object name for INPUT file location

ITU_DIRECTORY

This parameter is used to define the Oracle
directory object name for ITU file location

ITU_PROCESSED_DIRECTORY

This parameter is used to define the Oracle
directory object name for ITU file location

IVR_DIRECTORY

This parameter is used to define the Oracle
directory object name for IVR file location

IVR_PROCESSED_DIRECTORY

This parameter is used to define the Oracle
directory object name for IVR file location

JSC_TIMEOUT

This parameter is used to set the polling interval for
job scheduler. Input parameter value is numeric. To
check whether it represents minutes/seconds.

JSV_ARCHIVE_SERVER_CONFIG

This parameter is used to set the configuration file
for reports archive server. Input parameter value is
user defined.

JSV_ARCHIVE_SERVER_URL

This parameter is used to specify the archive
server url. Input parameter value is user defined.

JSV_BI_PASSWORD

This parameter is used to define the Bl Publisher
Password

JSV_BI_USER

This parameter is used to define the Bl Publisher
User ID

JSV_TEMPORARY_DIRECTORY

This parameter is used to define Oracle directory
object name for Job Service Temp file location

JSV_BI_PASSWORDJSV_REPORTS_RUNTIME

This parameter is to specify the reports runtime
program. Input parameter value is user defined.

JSV_REPORTS_RUNTIME_CMDFILE

This parameter is used to specify the reports
runtime command file. Input parameter value is
user defined.

JSV_REPORTS_SERVER_CONFIG

This parameter is used to specify the configuration
file for reports server. Input parameter value is user
defined.

JSV_REPORTS_SERVER_URL

This is used to specify the URL for the reports
server. Input parameter value is user defined.

JSV_REPORT_ARCHIVE_DIRECTORY

This is used to specify the path and directory of
Reports archive, input parameter value being
numeric.

JSV_SMTP_SERVER

This parameter specifies the SMTP server used by
job service for sending email messages. Input
parameter value is user defined.

JSV_TIMEOUT

This is to specify the polling interval for the job
service during time out. Input parameter value is
numeric. To check whether it represents minutes/
seconds.

JSV_USE_BI_PUBLISHER

This parameter defines whether Bl publisher
should be used to process reports are not. Input
parameter value is Boolean (Yes/No).
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JSV_USE_REPORTS_SERVER

This parameter is used to specify whether reports
server from job service should be used or not.
Input parameter value is Boolean (Yes/No).

LBX_TXN_GROUPING_CNT

This parameter is used to specify the no. of records
per batch for payment transactions and lock box
batch records. Input parameter value is numeric.

LCO_COL_LETTER1_GEN_DAYS

This parameter specifies the number of days post
which first collection letter should be generated for
accounts with dues unpaid. Input parameter value
is numeric.

LCO_COL_LETTER2_GEN_DAYS

This parameter specifies the number of days post
which second collection letter should be generated
for accounts with dues unpaid. Input parameter
value is numeric.

LCO_COL_LETTER3_GEN_DAYS

This parameter specifies the number of days post
which third collection letter should be generated for
accounts with dues unpaid. Input parameter value
is numeric.

LIEN_RELEASE_DAYS

This parameter is used to define the Lien Release
Days

LOCKBOX_DIRECTORY

This parameter is used to define the Oracle
directory object name for Lockbox file location

LOCKBOX_PROCESSED_DIRECTORY

This parameter is used to define the Oracle
directory object name for processed Lockbox file
location

LOR_ADVERSE_ACTION_GEN_DAYS

This parameter is used to specify the number of
days after the third collection letter post which the
adverse action letter is to be generated. Input
parameter value is numeric.

LOG_LOB_PURGE_DAYS

This parameter is used to log files header table
purge days

MAX_AGED_TXN_AUTHORIZE_ DAYS

This parameter is used to specify the maximum
number of days within which a transaction should
be authorized. Input parameter value is numeric
and represents the number of days.

MAX_VOID_TXN_AUTHORIZE_DAYS

This parameter is used to set the maximum days to
authorize transaction

OCP_CUSTOMER_PMT_SITE_ID

This parameter is used to set the customer
payment extract file site id

OCP_INCLUDE_ACH_ACC

This parameter is used to set the customer
payment extract including ach accounts

OUTGOING_LOB_PURGE_DAYS

This parameter is used to define the outgoing
process file table purge days

OUTPUT_DIRECTORY

This parameter is used to define Oracle directory
object name for OUTPUT file location

PAC_ARCHIVE_DAYS

This parameter is used to define number of days
for periodic archiving of account. Input parameter
value is numeric.

PAC_OARCHIVE_DAYS

This parameter is used to define the number of
days for archiving accounts from O tables i.e. old
tables. Input parameter value is numeric
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PAP_ARCHIVE_DAYS

This parameter is used to define the number of
days for archiving applications on a periodic basis.
Input parameter value is numeric.

PAP_OARCHIVE_DAYS

This parameter is used to define the number of
days for archiving applications from O tables. Input
parameter value is numeric.

PCU_CHECK_REFUND_DAYS

This parameter is used to specify the maximum
number of days within which an overpayment from
the customer can be refunded. Input parameter
value is numeric.

PDC_PRE_PROCESS_DAYS

This parameter value will define the number of
days prior to the due day, regular account PDC
process should be initiated. Input parameter value
is numeric.

PENDING_PDC_DAYS

This parameter value will define the number of
days before the initiation day for pending PDC
accounts.

PGL_ARCHIVE_DAYS

This parameter defines the number of days, post
which the transactions in GL would be archived.
Input parameter value is numeric.

PGL_OARCHIVE_DAYS

This parameter is used to define the number of
days, post which the transactions in GL will be
moved to the O tables. Input parameter value is
numeric.

PJR_PURGE_DAYS

This parameter is used to specify the days post
which the job requests are to be purged. Input
parameter value is humeric.

POD_PURGE_DAYS

This parameter is used to define the number of
days after which the Output data file headers are to
be purged. Input parameter value is numeric.

PPA_ARCHIVE_DAYS

This parameter is used to specify number of days
after which pools and its transactions archiving is to
be done to O tables. Input parameter value is
numeric.

PPA_OARCHIVE_DAYS

This parameter is used to specify number of days
after which pools and its transactions archiving is to
be done to OO tables. Input parameter value is
numeric

PPR_ARCHIVE_DAYS

This is used to specify the days for archival of
producers details on a regular basis. Input
parameter value is numeric.

PPR_OARCHIVE_DAYS

This is used to specify the days after which the
producers details from O tables need to be
archived. Input parameter value is numeric.

PPX_ARCHIVE_DAYS

This is used to specify the days after which
producer transactions are to be archived. Input
parameter value is numeric.

PPX_OARCHIVE_DAYS

This is used to specify the days after which the
producer transactions are to be moved from O
tables. Input parameter value is numeric.

PJR_COPY_PURGED_DATA

This parameter is used to copy data into purge
tables.
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PST_ARCHIVE_DAYS

This parameter specifies the number of days for
which the statements are to be archived. Input
parameter value is humeric.

PST_OARCHIVE_DAYS

This parameter specifies the number of days for
which the statements are to be archived in the O
tables. Input parameter value is numeric.

PTT_PURGE_DAYS

This is used to specify the number of days after
which the PTT table is to be purged. Input
parameter value is numeric.

PTX_ARCHIVE_DAYS

This parameter is used to specify the number of
days the transactions are to be archived. Input
parameter value is humeric.

PTX_OARCHIVE_DAYS

This parameter is used to specify the number of
days after which the archived transactions from O
tables are to be moved. Input parameter value is
numeric.

PUL_PURGE_DAYS

This parameter is used to specify the number of
days post which the User login details are to be
purged. Input parameter value is numeric.

PVA_ARCHIVE_DAYS

This parameter stores the number of days for
archival of regular vendor assignments. Input
parameter value is numeric.

PUP_ARCHIVE_DAYS

This parameter stores the number of days for
archival of transaction upload. Input parameter
value is numeric.

PUP_OARCHIVE_DAYS

This parameter is used to specify the number of
days after which the archived transactions from O
tables are to be moved. Input parameter value is
numeric.

PVA_OARCHIVE_DAYS

This parameter value specifies the number of days
for archival of vendor assignments from O tables to
OO tables. Input parameter value is numeric.

PVI_ARCHIVE_DAYS

This parameter is used to specify the number of
days for which the regular vendor invoices are to be
archived. Input parameter value is numeric.

PVI_OARCHIVE_DAYS

This parameter is used to specify the number of
days post which the regular vendor invoices are to
be moved from O tables to OO tables. Input
parameter value is numeric.

RAC_LOAD_FREQUENCY

This parameter is used to specify Accounts RDH
Load Frequency

RAP_LOAD_FREQUENCY

This parameter is used to specify Applications RDH
Load Frequency

RAT_LOAD_FREQUENCY

This parameter is used to specify Asset Tracking
RDH Load Frequency

RBK_LOAD_FREQUENCY

This parameter is used to specify Bankruptcy
Details RDH Load Frequency

RCA_LOAD_FREQUENCY

This parameter is used to specify Call Activities
RDH Load Frequency

RCH_LOAD_FREQUENCY

This parameter is used to specify Deficiency
Details RDH Load Frequency
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RCO_LOAD_FREQUENCY

This parameter is used to specify Contracts RDH
Load Frequency

RFO_LOAD_FREQUENCY

This parameter is used to specify Repo-
Foreclosure RDH Load Frequency

RPR_LOAD_FREQUENCY

This parameter is used to specify Producers Rdh
Load Frequency

RST_LOAD_FREQUENCY

This parameter is used to specify Setup Data RDH
Load Frequency

RTX_LOAD_FREQUENCY

This parameter is used to specify Txns RDH Load
Frequency

SALESAGENT_MAIL_SEND_IND

This parameter is used to specify whether decision
fax needs to be sent to sales agent (yes/no)

SCORING_PARAMETER_ ALERT

This parameter is used to set the scoring
parameter alert

SQL_DIRECTORY

This parameter is used to set the Oracle directory
object name for SQL file location

TES_ANA_PRE_PROCESS_CYCLES

This parameter is used to specify the pre-process
cycles required for Escrow analysis. Input
parameter value is numeric.

TES_DSB_ANALYSIS_PERCENT

This parameter is used to specify the percentage
for escrow disbursements. Input parameter value is
numeric.

TES_DSB_PRE_PROCESS_DAYS

This is used to specify the number of days for pre-
process for escrow disbursements. Input parameter
value is numeric.

TPE_AMORTIZE_ACCRUED_INT_ONLY

This parameter is used to specify that system has
to amortize accrued interest at month end

TPE_APPLY_LTC_FROM_CURR_DUE_DT

This parameter is used for pyramid law fee method
to apply late charge from current due date

TPE_ESC_ANALYSIS_ DELQ_AMT

Parameter considers billed but uncollected amount
for escrow analysis

TPE_EXCESS_PAYMENT_TO_MEMO

Excess payment on the account will be moved to
memo payment.

TPE_EXCLUDE_ESC_LTC

This parameter defines whether escrow should be
included or excluded while calculating late charge.
Input parameter value is Boolean (Yes/No).

TPE_EXT_CYCLES_BACKDATED

This parameter is used to define the maximum
extension cycles allowed for back dating. Input
parameter value is numeric with no upper limit

TPE_FUTURE_PAYOFF_DAYS

The value specified in this parameter validates the
Valid Up to Date with Payoff quote during
monetary transactions posting.

TPE_GL_REFUND_ HOLD_DAYS

This parameter is used to define the number of
days the non-refunded amount can be held in GL.
Input parameter value is numeric.

TPE_MAX_CYCLES_BACKDATED

This parameter is used to define the maximum
cycles that are allowed for back dating in OFSLL.
Input parameter value is numeric.
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TPE_MIN_1098 INT_AMT_PAID This parameter is used to specify the lower limit or
minimum interest amount paid for 1098 i.e.
Mortgage Interest Statement. In the US, Fls need
to report mortgage interest of $600 or more
received from individuals, during the course of their
business. Input parameter value is 600, the
minimum value above which reporting by Fl is
required in form 1098 for each mortgage account.

TPE_OLDEST_DUE_DT_NEW_MTHD This parameter is enabled to specify whether new
method for calculation of oldest due date based on
given data should be used or not. Input parameter
value is Boolean (Yes/No).

TPE_PAID_TO_CLOSE_DAYS This parameter is used to specify the number of
days allowed post which a paid account would be
closed. Input parameter value is numeric.

TPE_PAYMENT_TO_MULTI_ACCOUNTS This parameter is enabled to allow one payment for
dues in multiple accounts. Input parameter value is
Boolean (Yes/ No).

TPE_PAYOFF_VALID_THRU_DAYS This parameter is used to specify the number days
the pay-off quote is valid by default. i.e. if the
parameter is set as 7, the payoff quote is valid for 7
days and customer can pay the quoted amount as
final closure amount within those days. Input
parameter value is numeric.

TPE_PMT_POST_EOD This parameter is used to allow payments when the
batch process for End of Day is running. Input
parameter value is Boolean (Yes/No). If this is set
to Y, payments can be allowed during EOD.

TPE_SCHGOFF_DLQ_DAYS This parameter is used to define the number of
delinquent days to treat an account for SCHGOFF
(charge — off). Input parameter value is numeric.
(To verify)

TPE_SCHGOFF_REVIEW_DAYS This parameter is used to define the number of
days allowed for review of SCHGOFF accounts.
Input parameter value is humeric.

TPE_SCRA_DEFAULT_INTEREST_RATE This parameter is used to define the default interest
rate that is to be applied for customers who are in
military duty. OFSLL will apply the lower of the
prevailing interest rate or SCRA default interest rate
specified through this parameter. Input parameter
value is numeric (in this case 6, which is interest
rate to be applied for SCRA accounts.

TPE_SHOW_BACKDATE_WARNING This parameter is used to define whether a warning
message is to be shown if monetary transaction is
backdated.

TPE_STM_INC_ALL_TXNS This parameter is enabled to define whether all

transactions should be included in the statements
or otherwise. Input parameter value is Boolean

(Yes/No).

TPE_STOP_COMP_DELQ _DAYS This parameter is used to stop computation when
delq days > 60

TPE_TXN_POST_DEFAULT GLDATE This parameter is used to default GL date in date

type parameters during txn posting (y/n)
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TPE_VOID_TO_CLOSE_DAYS

This parameter is used to define the number of
days allowed for closing Void accounts. Input
parameter value is humeric.

UIX_DEFAULT IMAGE_PATH

This parameter is used to define the default image
directory maintained for the purpose of online
attachment of document images to an application
using documents maintenance section under
Account documentation. Input parameter value is
user defined.

UIX_INCOMING_FILE_PATH

This parameter is used to specify incoming file path
of app server

UIX_LOCAL_COUNTRY_CD

Through this parameter we can set the local
country where an FI has multiple branches across
different geographies. Input parameter value is user
defined.

UIX_LOCK_UNLOCK_AND_COPY

This parameter is used to enable the user interface
lock / unlock and copy features. Input parameter
value is Boolean (Yes/No).

UIX_MAX_ACC_SEARCH_ROWS

This parameter is used to specify the maximum
number of account rows to be returned for search
functionality. Input parameter value is numeric.

UIX_MAX_APP_SEARCH_ROWS

This parameter is used to specify the maximum
number of application rows to be returned for
search functionality. Input parameter value is
numeric.

UIX_OUTGOING_FILE_PATH

This parameter is used to specify outgoing file path
of app server

UIX_REPORTS_SERVER_CONFIG

This parameter can be used to specify the user
interface reports server configuration file. This is
not required for OFSLL.

UIX_REPORTS_SERVER_URL

This parameter sets the URL for Reports server.
Input parameter value is user defined.

UIX_UTILITIES_SERVLET_URL

This parameter can be used to specify the User
Interface utilities servlets URL. This is not required
for OFSLL.

UPR_PRO_NBR_SYS_GENERATED

This parameter can be used to specify whether
producer number should be system generated or
seek input from user. Input parameter value is
Boolean (Yes/No). Generally this is set to yes for
system generation.

VEV_NADA_TOKEN_URL

This parameter is used to set the token URL for
vehicle evaluation interface NADA. Input parameter
value is user defined.

VEV_NADA_UPDATE_DAY

This parameter is used to specify the day of the
month to update the vehicle evaluations every
month. Input parameter value is numeric.

VEV_NADA_URL

This parameter is used to set the URL for vehicle
evaluation interface NADA. Input parameter value
is user defined.

VEV_NADA_USER_ID

This parameter is used to specify the User id for
login to the NADA interface. Input parameter value
is user defined.
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VEV_NADA_USER_PASSWORD

This parameter is used to specify the password for
login to the NADA interface. Input parameter value
is user defined.

VEV_VALUATION_REGION

This parameter is used to define the default region
for vehicle evaluation. Input parameter value is the
region name, and is user defined.

VEV_VALUATION_SOURCE_CD

This parameter is used to specify the default
vehicle evaluation source code. Input parameter
value is user defined. A number of parameters are
possible in OFSLL as below:

1. Appraisal Company

2. Broker

3. BUC GUIDE

4. DATA QUICK

5. NAMS/SAMS SURVEY — USED
6. REALTOR

7. NADA INTERFACE USED CARS

8. BLACKBOOK INTERFACE USED CARS
9. KELLY INTERFACE

10. NADA — NEW

11. NADA - USED

12. KELLY NEW BLUE BOOK

13. KELLY USED BLUE BOOK

14. INVOICE

15. BLACK BOOK

16. NADA INTERFACE COMMERCIAL TRUCKS
17. COMPANY INVOICE

18. GOLD BOOK

19. GALVS

20. OTHER

21. ALG

WFP_DIRECTORY

This parameter is used to specify the Oracle
directory object name for WFP file location.

WFP_MAX_CYCLES_BACKDT

This parameter is used to specify the back dated
cycles date for WFP.

WFP_PROCESSED_DIRECTORY

This parameter is used to define oracle directory
object name for wfp file location.

WFP_REVERSE_TXN_IND

This parameter is enabled to define the WFP
reversal indicator. Input parameter value is Boolean
(Yes/No).
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XAE_DEALUPD_MAX_ALLOWED_DAYS

This parameter is used to define the max allowed
days for Deal Update.

XAE_DEALUPD_ALLOWED_IND

This parameter is used to indicate whether deal
update is allowed or not.

OUTBOUND_CALL_Q

This parameter is used to generate reports
(including emailing statements/letters) using
Application Server instead of Database server.

ACA_PRE_PROCESS_DAYS_FIRST

This parameter is used to configure the number of
days before the debit day for ACH process in first
time/ one-time case.

IPR_PROCESSED_DIRECTORY

This parameter is used to define the Oracle
directory object name for processed IPR file
location

IPR_DIRECTORY

This parameter is used to define the Oracle
directory object name for IPR file location

UIX_PWD_MGMT_EXTERNAL_URL

This parameter is used to set external password
management url, if applicable.

UIX_PWD_MGMT_EXTERNAL

This parameter is used to define the parameter if
password management is external. (SET Y IF
PASSWORD MANAGEMENT IS EXTERNAL (Y/

N)).

ICU_PROCESSED_DIRECTORY

This parameter is used to define the Oracle
directory object name for processed ICU file
location

ICU_DIRECTORY

This parameter is used to define the Oracle
directory object name for ICU file location

UIX_BILL_CYCLE_ALLOWED_IND

This parameter is used to indicate whether Billing
cycle is allowed at the application level

CMN_EOD_SLEEP_MINS

This parameter is used to set in minutes the EOD
sleep time

CMN_CORE_BANK_TXN_CD

This parameter is used to set code for OFSLL and
Core Banking integration

ICC_DLQ_AMT_EXCLUDED

This parameter enabling will exclude delinquency
amount for CASA account

CMN_CORE_BANK_IND

This parameter is used to set whether OFSLL can
integrate with Core Banking.

BKRP_FILE_REC_LIMIT

This parameter is used to set the limit of total
number of records allowed to be added in the Input
Data File shared from external interface.

Note: If the number of records exceeds the set
limit, multiple Input Data Files are to be created.

UVN_VEN_NBR_SYS_GENERATED

This parameter is used to validate if Vendor
Number has to be auto generated (if set to Y) or to
be specified manually in the Vendor details screen.
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METRO_WITHOUT_COLL_IND This parameter indicates whether Metro Il reporting
is handled without OFSLL Collections module
being used. If the parameter value is setas Y i.e.
collection module is not used, system updates the
collateral status directly as part of REPO call
activity.
However when Collections module is being used,
the Collateral status is tracked with the
repossession details updated in Repo/Foreclosure
screen of Collections module.

METROII_FIRST _DELQ_DT_ADD_ DAY This parameter is used to calculate the first
delinquency date that needs to be reported in the
Metro Il reporting file.

By default the parameter is disabled indicating that
the initial delinquency date calculated by the
system is used for Metro Il reporting. The same
needs to be enabled to add the parametrized
number of days to the system calculated first
delinquency date for the Metro Il reporting purpose.

DAYS TO PULL_CRB_REPORT This parameter is used to configure the number of
days permitted to pull a Bureau report from the
same company and for the same customer.

XWS_ACS_RESP_MULTI_RECORD_IND This parameter is used to indicate if multiple
records exist in the response file received for
account search.

Accordingly, when there are multiple records found
and this parameter is enabled and set to No
(default), system displays an error message Too
Many Records Found. Please Refine Search by
Adding One More Parameter.

However, when this parameter is set to Yes,
system only indicates that there are multiple
records/rows in response file.

GRI_DLQ_DAYS_AUTO_STATUS_CHG This parameter is used to define the delinquency
days which inturn is used to automatically update
the status of a work order to PENDING ON HOLD
status.

TPE_PMT_POSTING_CLS_ACCOUNT This parameter is used to define the payment
posting criteria for Closed - Paid Off/ Charged-off
accounts.

Accordingly, OFSLL accepts payment posting on
closed accounts only when the parameter is set to
Y and all the payments received through Payment
Entry screen or Payment Upload file are posted to
a Suspense account.
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TPE_BACKDT_PMT_ POSTING

This parameter is used to define the payment

posting criteria for backdated payments for the

following type of account conditions:

e Paid off

e Charged-off

* Account under activation

*  Account under conversion

*  Non-performing Account

*  PC2 Sl (Pre-computed to Simple Interest)
Reschedule

Accordingly, OFSLL accepts backdated payment
posting only when the parameter is setto Y and all
the payments received through Payment Entry
screen or Payment Upload file are posted to a
Suspense account.

EXP_PA_SOFT_PULL_IND

This parameter when enabled allows Soft Pull
Credit Bureau request, specifically for Experian
Premier Attribute Consumer Report without
impacting the consumer FICO score.

PMT_BATCH_POSTING

This parameter (PAYMENT BATCH POSTING
PREFERENCE) is used to define the status of
payment transactions which are uploaded in bulk
through a batch process.

POOL_ACTIVE_ACCOUNTS_ONLY

This parameter controls the type of accounts that
can be added to a Securitization Pool and allows
adding only Active status accounts since the same
is enabled (value set to Y) by default. To add
accounts with other status such as Active, Paid Off,
Charged Off, Void, Terminate. and so on, set the
value of system parameter to N.

AUTO_GEN_ACC_NBR_CONV

This parameter is used for conversion accounts to
decide option of account number generation. If the
value of parameter is set to Y the account number
is automatically generated in OFSLL during
conversion and if the value is N, then external
reference number (generated in third party system)
itself is appended as the account number.

OUTBOUND_DLR_ TRACK_Q

This parameter defines the settings for batch job
SET_XPR to either use MDB (Message Driven
Bean) flow (if value set to Y) or existing work flow
(if value set to N) to dump producer details
maintained in the system into Dealer Track.

MDB flow generates outbound JMS message
though the configured MDB interface and can avoid
current database outbound calls and session
timeout.

In the existing workflow, the database makes
synchronous outbound calls to producer data dump
web service, to dump the data and acknowledge
the database with the status (success or failure).
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OUTBOUND_ROUTEONE_Q This parameter defines the settings for batch job
SET_XPR to either use MDB (Message Driven
Bean) flow (if value set to Y) or existing work flow
(if value set to N) to dump producer details
maintained in the system into ROUTEONE.

MDB flow generates outbound JMS message
though the configured MDB interface and can avoid
current database outbound calls and session
timeout.

In the existing workflow, the database makes
synchronous outbound calls to producer data dump
web service, to dump the data and acknowledge
the database with the status (success or failure).

GRI_WEBSERVICE_LOG_IND This parameter is used to decide on logging GRI
(Generic Recovery Interface) communications. If
enabled, system logs all the GRI related web
service communications between OFSLL and
external interfaced system.

The recorded logs can be viewed in Dashboard >
System Monitor > Database Server Log Files tab
by selecting Interfaces view option.

PVE_ARCHIVE_DAYS This parameter stores the number of days for
archival of regular vendors. Input parameter value
is numeric.

PVE_OARCHIVE_DAYS This parameter is used to specify the number of

days post which the regular vendors are to be
moved from O tables to OO tables. Input parameter
value is numeric.

LBX_DR_CR_VALIDATE_AMT_IND This parameter (VALIDATE LOCKBOX DR/CR
BATCH TOTALS) is used to facilitate NACHA file
validation. Based on the status of the parameter,
system is either allowed to validate the file or
process without validation.

PAP_PURGE_DAYS This parameter allows to define the number of days
after which the application data from archival
folders are to be deleted permanently. Purging
happens based on elapsed number of days i.e. if
value is set to 60 days, only those records which
are older by 60 days in archival folder are deleted.

PAC_PURGE_DAYS This parameter allows to define the number of days
after which the accounts data from archival folders
are to be deleted permanently. Purging happens
based on elapsed number of days i.e. if value is set
to 60 days, only those records which are older by
60 days in archival folder are deleted.

CMN_SED_FILE_PROCESS TO_LOB This parameter allows to define the location from
where the incoming or outgoing seed data is to be
processed. If setto Y, system processes the data
to/from LOB and if set to N, system processes the
data to/from FILE.
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CMN_EDF_FILE_PROCESS_TO_LOB

This parameter allows to define the location from
where the incoming or outgoing data from Dialer
Interface is to be processed. If setto Y, system
processes the data to/from LOB and if set to N,
system processes the data to/from FILE.

The same is used by the batch jobs
EDFADR_BJ_100_01 and EDFIVR_BJ_100_01
which are available in SET-EDF Batch Job Set.

CMN_FAX_FILE_PROCESS_TO_LOB

This parameter allows to define the location from
where the incoming or outgoing Fax data is to be
processed. If setto Y, system processes the data
to/from LOB and if set to N, system processes the
data to/from FILE.

CMN_RED_FILE_PROCESS_TO_LOB

This parameter allows to define the location from
where the outgoing details of Data Masking Policy
(i.e. Redaction policy output file) is to be
processed. If setto Y, system processes the data
from LOB and if set to N, system processes the
data from FILE.

CMN_WFP_FILE_PROCESS_TO_LOB

This parameter allows to define the location from
where the incoming or outgoing WFP Unit details
are to be processed. If set to Y, system processes
the data to/from LOB and if set to N, system
processes the data to/from FILE.

The same is used by the batch job
WUPPRC_BJ_132_01 available in SET-WFP Batch
Job Set.

CMN_AUD_FILE_PROCESS_TO_LOB

This parameter allows to define the location from
where the outgoing Audit scripts are to be
processed. If setto Y, system processes the data
from LOB and if set to N, system processes the
data from FILE.

CMN_LBT_FILE_PROCESS_TO_LOB

This parameter allows to define the location from
where the incoming or outgoing Lockbox files are to
be processed. If set to Y, system processes the
data to/from LOB and if set to N, system processes
the data to/from FILE.

The same is used by the batch jobs
LBXPRC_BJ 100 01 and LBXSEP_BJ 100 01
available in SET-LBT Batch Job Set.

CMN_ODD_FILE_PROCESS_TO_LOB

This parameter allows to define the location from
where the outgoing ODD or Output Data Dump
files are to be processed. If setto Y, system
processes the data from LOB and if set to N,
system processes the data from FILE.

The same is used by the batch job
ODDPRC_BJ_000_01 available in SET-ODD3
Batch Job Set.

ORACLE
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Table C-1 (Cont.) System Parameters

_________________________________________________________________________________|
Parameter Description

CMN_ALERT_DEBUG_ METHOD This parameter allows to define the location to
which Alert and Warning logs are to be written. If
set to ADVANCE_QUEUE, system writes the logs
in Logs table and if set to UTL_FILE, system
generates the alert log file.

CMN_GRI_WS_DEBUG_ METHOD This parameter allows to define the location to
which GRI (Generic Recovery Interface) web
service logs are to be written. If set to
ADVANCE_QUEUE, system writes the logs in
Logs table and if set to UTL_FILE, system
generates the log file.

UIX_CUSTOMER_BASED_PMT_IND If this parameter is set to Y and is Enabled, system
accepts posting direct payment to an account and
also accepts customer based payments to all linked
accounts.

To facilitate customer based payments, Customer/
Business # and Payment Hierarchy fields along
with Populate Accounts button are enabled in
Payment Entry screen to specify required values.

PMT_HIERARCHY_CODE In this parameter, you can specify a payment
hierarchy which is populated by default in Customer
Details and Business Details (if applicable) screen
after account activation.

However, the specified value is selected by default
only if there is a matching hierarchy definition
enabled record maintained in Setup >
Administration > User > Payment Hierarchy screen.
Else, Equal Amount value is selected which in-
turn adjusts the payment equally to all customer/
business linked accounts.

Note: System does not consider this parameter
value while creating account using existing
customer/business details since the default
selection is done during the creation of existing
customer / business account.

EVI_MAX_RETRY_COUNT This parameter records and controls the maximum
attempts to re-trigger FAILED Webhook requests
which cannot exceed more than 5 times. However,
this parameter can be modified if the maximum re-
trigger attempts is to be less than 5 times.

UIX_CUSTOM_LABEL_ENABLED_IND This parameter indicates if the field label
customizations are allowed i.e. ability to change
label and provide access to fields in Label
Configuration and Security User Access Definition
Details screens.

If setto Y, system refers data from database
If set to N, system refers data from XLIB file.
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Table C-1 (Cont.) System Parameters

_________________________________________________________________________________|
Parameter Description

UIX_MASTER_ACC_BASED_PMT_IND If this parameter is set to Y and is Enabled, system
accepts posting direct payment to a master
account and also accepts master account based
payments to all linked accounts.

To facilitate master account based payments,
Master Account # field is enabled in Payment
Entry screen.

TPE_PMT_REFUND_CURRENCY_SRC_CD This parameter indicates the currency in which
payment refund has to be processed in the system
as either Payment Currency or Account
Currency. The same is considered during payment
refund operation in Payment Maintenance screen.

AUTO_GEN_ACTIVE_TXN_CONV This parameter if enabled, auto posts a dummy
ACTIVE transaction on all migrated accounts
during the schedule batch job run. This in-turn
allows to post RESCISSION / VOID transaction
specifically for migrated accounts by selecting the
dummy transaction from Customer Service >
Maintenance screen or Transaction History
transactions tab,

For more information, refer Voiding an Account
section Servicing user guides.

FLL_CMN_JET_JWT_ENABLED_IND This parameter if set to Y, enables the Account

(JET JWT TOKEN ENABLE INDICATOR) Dashboard screen in Servicing LHS menu. This
screen is based on Oracle JET framework and
facilitates to view Account summary details
maintained in the system. For information on
screen functionality, refer to Servicing User
Manuals and for details on deployment and
configuration, refer to Installation Manuals.

FLL_CMN_JET_JWT_TOKEN_URL Define the value of the O-JET URL (app-shell
(JET JWT TOKEN GENERATION URL) application URL) in the format https://

<hostname>:<port no>/ofsll-appshell/< token>
FLL_SER_JET_ACC_CREATE_URL Define the value of the O-JET URL (app-shell
(JET SIMPLE ACCOUNT CREATE URL) application URL) in the format https://

<hostname>:<port no>/ofsll-appshell?
root=accountonboarding
FLL SER _JET _ACC_DASHBOARD_URL Define the value of the O-JET URL (app-shell

(JET ACCOUNT DASHBOARD URL) application URL) in the format https://
<hostname>:<port no>/ofsll-appshell?

root=accountdetailsdashboard
FLL_SET_JET_INTELLIGENTSEG_URL Define the value of the O-JET URL (app-shell

(JET INTELLIGENT SEGMENTATION URL) application URL) in the format https://
<hostname>:<port no>/ofsll-appshell?

root=queuecreation
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Table C-1 (Cont.) System Parameters
]

Parameter Description
ACCOUNT_PROCESSING_THRESHOLD This parameter allows to restrict the number of
(ACCOUNT ON-BOARDING ASYNCHRONOUS  accounts that can be created synchronously
PROCESSING THRESHOLD) using Account onboarding WebService.

However, creating accounts asynchronously in the
system is further processed by the below batch
jobs based on valued defined in this parameter.

SET-API2 (ASYNCHRONOUS ACCOUNT

CREATION)

< ACXVAL_BJ_100_01 (VALIDATE IAPP TABS)

< ACXAAI_BJ_100_01 (ASYNCHRONOUS
ACCOUNT CREATION)

VTX_OUTBOUND_URL (OUTBOUND CALL URL This parameter defines the URL of the external

FOR VERTEX) adapter (Vertex) that is used to integrate with
OFSLL.

VTX_VERSION (VERTEX VERSION) This parameter defines the version of Vertex
adapter that is required to be configured by the
system.

AUTO_GEN_AGREEMENT_NBR (AUTO This parameter defines the mode by which

GENERATE AGREEMENT NUMBER FOR agreement number is generated to an account. If

ACCOUNT ONBOARDING) set to Y, system generates the agreement number.

If set to N, system accepts the external agreement
number provided in Account on-boarding payload.

Note: When system parameter is set to Y, the
agreement number is also used as an identifier to
validate the contract details and decide on which
accounts should get same Agreement number.

C.3 Organization Parameters

ORACLE

Organization parameters control the functions related to User login, password expirations,
responsibilities and accessibility limits in the OFSLL system. Individual parameters can be
created with different values for uniquely defined organizations, divisions, and responsibility
combinations.

There are three more dimensions other than parameter name, description and enabling
(similar to system parameters) as indicated below:

1. Organization
2. Division
3. Responsibility

These dimensions help to define the applicability of the responsibility for specific User in an
Organization across selected Divisions/departments.

When determining which parameter to use, OFSLL system selects the best match based on a
hierarchical sort by the Organization, Division, and Responsibility fields, with values of ALL
being a lower order match than an exact match.

While the system allows for Organization parameters to be defined at all three hierarchical
levels (organization, division, and responsibility), not all will be applicable to each parameter.
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Table C-2 Organization Parameters

_________________________________________________________________________________|
Parameter Description

MAX_PASSWORD_HISTORY_CHECK This is used to set limit for number of times a
password has been repeated during password
change. This can be set for specific branches of the
Organization, Divisions and Users based on
responsibilities. Numeric value to be input to
specify the limit.

UCS_GROUP_FOLLOWUP_DAYS This parameter is used to set up the number of
days range for Group follow-up field in customer
service screen which displays the set of accounts
that share same account condition as the selected
account and bear the same customer ID. The pre-
requisite for this is Group Follow-up indicator
should be enabled in queue setup. Input value is
numeric.

UCS_REVIEW_QUEUE_ALLOWED This is used to specify whether review can be done
by the specific responsibility (user group) without
entering details in call activities/activities.
Parameter value to be input is Boolean (Yes/No).

UIX_APP_VIEW_ALL_APPS The system uses this parameter to determine
which users have the ability to view all applications.
The system selects the best match based on a
hierarchical sort by Organization, Division and
Responsibility fields, with values of ALL being a
lower order match than an exact match. Input
parameter value is Boolean (Yes/No).

UIX_HIDE_RESTRICTED_DATA This is used to hide sensitive data relating to the
Contract / Applicant to a specific group/
responsibility etc. Suppose there is a need to hide
data relating to SSN, Bank account details etc. to a
specific user responsibility who will not need such
data, this parameter can be enabled with input
value Boolean (Yes/No). If this parameter is set to
Y, the details appear in a masked format (for e.g.
SSN — XXXXX- 456)

UIX_SMTP_SERVER This parameter is used to set up the email server
for user interface. The input value would be SETME
and check the Enable flag.

UIX_VIEW_SECURED_ACCOUNTS This is used to specify whether an account can be
viewed by a specific responsibility (users).
Parameter value is Boolean (Yes/No) and when
flagged as Yes, such accounts would be viewable
only by users defined in the Organization, Division
hierarchy with the specified responsibilities. For
example, all employee accounts may not be
viewable by all users and should be made available
only to the HR department with specific
responsibility levels.

Note: While creating application, selecting
appropriate applicant’s classification would be
essential for this parameter to be effective.
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Table C-2 (Cont.) Organization Parameters

_________________________________________________________________________________|
Parameter Description

UIX_VIEW_SECURED_APPLICATION This is used to specify whether an application can
be viewed by a specific responsibility (users).
Parameter value is Boolean (Yes/No) and when
flagged as Yes, such applications would be
viewable only by users defined in the Organization,
Division hierarchy with the specified
responsibilities. For example, all employee
accounts may not be viewable by all users and
should be made available only to the HR
department with specific responsibility levels.

Note: While creating application, selecting
appropriate applicant’s classification would be
essential for this parameter to be effective.

ULG_DAY_END This is used to specify the upper limit time in day
for a user to be able to work in the System.
Parameter value is numeric and range is 1-24, else
system will throw error.

ULG_DAY_START This is used to specify the lower limit time in day for
a user to be able to work in the System. Parameter
value is numeric and range is 0-24, else system will
throw error.

ULG_FAILED_LOGIN_TRIALS_MAX This parameter is used to specify the maximum
number of login trials allowed before disabling the
User ID due to security reasons. Input parameter
value is numeric with upper limit of 999999999999.

ULG_INACTIVITY_DAYS_MAX This parameter is used to specify the maximum
number of days the User ID can be without
utilization before disabling the User ID due to
security reasons. Within the specified number of
days the User Id must be utilized for sign in at least
once. Input parameter value is numeric with upper
limit of 999999999999.

ULG_PWD_CASE_SENSITIVE_REQ This is used to allow all passwords to be case
sensitive or otherwise. Input parameter value is
Boolean (Yes/No). When this parameter is set as
NO, password would be stored in Upper case. If
this parameter is set to N then the
ULG_PWD_LOWER_CHAR_REQ parameter
should also be set to N.

ULG_PWD_CHANGE_DAYS ACTUAL This is used to set the maximum number of days
after which system will force a password change, in
cases where the User has not changed the
password. Input parameter value is numeric with
upper limit of 999999999999.

ULG_PWD_CHANGE_DAYS_PROMPT This is used to set the maximum number of days
after which system will prompt the User for
password change, in cases where password has
not been changed within the set period. Input
parameter value is numeric.

ULG_PWD_LENGTH_MIN This is used to set the minimum length of password
string that is required. If this criterion is not met,
system would throw an alert specifying minimum
character length required to be input.
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Table C-2 (Cont.) Organization Parameters

_________________________________________________________________________________|
Parameter Description

ULG_PWD LOWER_CHAR_REQ This is used to allow at least one lower case
character in password strings. Input value is
Boolean (Yes/No). Setting this as NO would mean
passwords would be allowed in uppercase only.

ULG_PWD_NBR_REQ This parameter allows setting password with at
least one numeric character. Input value is Boolean
(Yes/No) and setting this as YES would require
passwords to have at least one numeric character.

ULG_PWD_SPECIAL_CHAR_REQ This parameter is used to allow special characters
like ‘'$’, ‘#, ‘@’, in passwords. Input value is
Boolean (Yes/No) and setting this as YES would
require passwords to have at least one special
character.

ULG_PWD_UPPER_CHAR_REQ This is used to allow at least one upper case
character in password strings. Input value is
Boolean (Yes/No). Setting this as NO would mean
passwords would be allowed in lowercase only.

ULG_WEEK_END This parameter enables to set the last day of the
week when a user can have access to the system.
Input parameter value is numeric ranging from 1 to
7. This is useful in business requirements where
the Organization does not need a specific set of
responsibilities (users) to not access the system on
a weekend / week-off day etc.

ULG_WEEK_START This parameter is used to set the start day of the
week when a user is allowed to access the system.
Input parameter value is humeric.

CRB_ERROR_VALIDATION_IND This parameter is used to validate the Credit
Bureau report generation request depending on the
number of days permitted to pull a Bureau report
from the same company and for the same
customer and report as either warning/error.

When the number of days is less than or equal to
the permitted days (as defined in parameter
DAYS_TO_PULL_CRB_REPORT), system
displays an Error message stating Bureau Report
exists for the same Customer from the same
Bureau for Account# XYZ along with list of
account number(s) and/or application number( s). If
not, a Warning message is display and request is
accepted for processing.

Note: Both CRB_ERROR_VALIDATION_IND and
DAYS_TO_PULL_CRB_REPORT are to be
enabled for Credit Bureau report processing.

OCP_CUST_PMT_PREF This parameter MASTER ACCOUNT ROLLUP
FOR PMT EXTRACT FILE is used to decide the
basis of dues consolidation at master account level
based on the parameter values selected. For more
information, refer to Outbound Customer
Extracts To Payment Agencies Batch section.
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Appendix C
Company Parameters

Company parameters control the processes associated with functions that vary for different
companies and branches. These parameters address credit scoring, credit bureau interfaces,

fax services, and fax generation.

Individual parameters may be set up with different values for uniquely defined company and
branch combinations (i.e. these can be defined to the level of branches in each company or a

group of companies in terms of applicability).

Table C-3 Company Parameters

Parameter

Description

AUD_ADV_REASON_MODEL

This parameter is used to set-up default adverse
action reasons for scoring models during set-up in
the Parameters sub page. Whenever the flag
Bureau Score Reasons is unchecked during
credit bureau scoring model set-up, then
automatically rejected applications scored using
this scoring model picks up the Adverse Action
Reasons from the Parameters sub page.

AUD_SCORING_METHOD

This parameter is used to set when/where the
application scoring method has to be applied within
the company. So when the parameter value is
chosen as primary applicant only, the system will
perform the application scoring for the primary
applicant only and according to other applicable
parameters specified. Other parameter input values
are Minimum Score, Maximum Score, Minimum
Tier (Grade), Maximum Tier (Grade).

AUD_SCORING_METHOD_IN_BUREAU

This parameter is used to define what value to be
picked up for application scoring from the scores
returned from the various bureaus. The input
parameter values are Maximum Score and
Minimum Score. If Maximum score is setup in
company parameters, then for all applications
where a bureau report is pulled, the system will
pick-up the Maximum score from the different
bureaus.

CBU_DATA_SET _SIZE

Parameter to define the metro 2 file data selection
criteria, option values are monthly, Daily, weekly,
semi monthly.

CBU_FILE_FORMAT

Metro 2 file format definition, user need to select
from the parameter value drop down.

CMN_ASE_VALIDATE_MAKE_MODEL

This parameter is set up to specify to the system
whether it needs to validate the asset make and
model at the time of data entry. In parameter value
is Boolean (Yes/No).

CMN_CMB_DEFAULT_PRINTER

This is used to define the default printer for printing.
The input parameter value is the printer name.
There is no LOV for this field. If no default printer is
defined and the parameter enabled, the system
would display Undefined.

ORACLE
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Table C-3 (Cont.) Company Parameters

_________________________________________________________________________________|
Parameter Description

CMN_WEEKLY_NONBUSINESS_DAYS This parameter is used to set-up the weekly
holidays at the company level. The input parameter
value is character string; if no details specified and
parameter is enabled, system would display
UNDEFINED.

COR_STORAGE_DIRECTORY This parameter is used to specify the path/location
for Oracle directory object template for
correspondence documents. Input parameter value
is SETME; if none is specified and parameter
enabled, UNDEFINED.

DBR_JOINT_INC_DEBT_WITH_2NDRY This parameter defines whether system should
consider income and debt details of the Spouse
and Secondary Applicant along with that Primary
Applicant. Input parameter value is Boolean (Yes/
No).

DBR_JOINT_INC_DEBT_WITH_SPOUSE This parameter is used to define whether system
should consider the income and debt details of
Spouse alone along with that of Primary applicant
details. Input parameter value is Boolean (Yes/No).

DDP_CRB_EXPIRATION_DAYS This parameter is used to define the credit bureau
report expiration days. So if this is set as 30,
system will use all available credit bureau reports
pulled which are not older than 30 days from
current day, during de-dupe. Input value is numeric
with no upper limit.

DDP_DEDUP_ DEBT_WITH_2NDRY This parameter defines whether the system should
dedupe credit bureau liabilities for Spouse and
Secondary Applicants, in addition to de-duping
Primary applicant’s liabilities. Input parameter value
is Boolean (Yes/No).

DDP_DEDUP_ DEBT_WITH_SPOUSE This parameter defines whether the system should
dedupe credit bureau liabilities for Spouse, in
addition to deduping Primary applicant’s liabilities.
Input parameter value is Boolean (Yes/No).

DOT_STORAGE_DIRECTORY This parameter is used to define the location/path
of the Oracle Directory Object name for Account
Document Loading. Input parameter value is
SETME.

ECB_EDIT_FAIL_ANY_APL This parameter is used to set the credit bureau edit
to fail in case the bureau report for any of the
applicant fails. Input parameter value is Boolean
(Yes/No). So if this parameter is set to YES, the
edit will fail even if one of the applicant’s bureau
score fails to qualify.

ECB_USE_APL_CURRENT_SCORE_CRH This parameter is used to define whether the
system should run the credit bureau edits only on
the current scored applicant bureau. Input
parameter value is Boolean (Yes/No).
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Parameter

Description

LOR_AUTOMATIC_CON_FUND_FAX

This is used to define the decision fax generation
when an application is funded. The input parameter
value is Boolean (Yes/No), and when this is set as
YES, system automatically generates the fax
approval in the predefined template whenever an
application is approved.

LOG_STORAGE_DIRECTORY

This parameter is used to define the Oracle storage
directory. Input parameter value is user (System
Administrator) defined.

LOR_AUTOMATIC_APPROVAL_FAX

This is used to define the decision fax generation
when an application is approved. The input
parameter value is Boolean (Yes/No), and when
this is set as YES, system automatically generates
the fax approval in the predefined template
whenever an application is approved.

LOR_AUTOMATIC_REJECTION_FAX

This is used to define the decision fax generation
when an application is rejected. The input
parameter value is Boolean (Yes/No), and when
this is set as YES, system automatically generates
the rejection fax in the pre-defined template
whenever an application is declined.

MAX_LEAD_DAY_AGE

This parameter is used to define the maximum no.
of days, post which the sales lead would be
considered cold. Input parameter value is numeric
with no upper limit.

MULTI_OFFER

Through this parameter the multiple offers (sub-tab)
in pricing can be enabled or disabled for a
Company/Branch. Input parameter value is
Boolean (Yes/No). If the flag is set as Y, the
underwriter can view multiple offers and select one
of them to be applied for the specific application.

MULTI_OFFER_MAX_NUMBER

This parameter is used to specify the maximum
number of multiple offers that can be permitted for
an application. Input parameter value is numeric
with no upper limit. If MULTI_OFFER company
parameter is set as N, this parameter can be
ignored as there is no use specifying a value.

MULTI_OFFER_MAX_TERM

This company parameter sets the maximum term
(as in no. of instalments, whichever billing cycle is
selected) for which multiple offers are calculated
and displayed during pricing. Input parameter value
is numeric.

MULTI_OFFER_ MIN_TERM

This company parameter sets the minimum term
(as in no. of instalments, whichever billing cycle is
selected) for which multiple offers are calculated
and displayed during pricing. Input parameter value
is numeric.

MULTI_OFFER_PMT_TOLERANCE

For Multi offer variance in payment is defined in this
parameter.

MULTI_OFFER_TERM_VAR

For multi offer Term variance will be defined in the
parameter.

PRESENT_VALUE_COMPUTE_RATE

This parameter will perform Present Value
Computation Rate (Inflation/Discounting Rate).
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Parameter Description

RATE_CHG_LTR_PRE_PROCESS DAYS This parameter is used to set up the number of
days prior to rate change effective date to generate
rate change letters in order to provide advance
intimation to customers. Input parameter value is
numeric with no upper limit.

STM_GEN_AFTER_MATURITY_IND This parameter is used to enable the statement
generation for an account after the maturity date
but Account remains unpaid. Input parameter value
is Boolean (Yes/No). If this is set to Y, statements
will get generated for accounts that remain unpaid
even after maturity.

UIX_RUN_AAI_ACT This parameter is used by the system to determine
whether to create and activate an account online.
Input parameter value is Boolean (Yes/No).

UIX_UCS_CAC_MAX_FOLLOWUP_DAYS This parameter is used to set up the maximum
number of days for follow up when the account is in
delinquent state. Input parameter value is numeric
with no upper limit.

UIX_UCS CAC_MAX_PROMISE_DAYS This parameter is used to set up the maximum
number of days allowed for customers who promise
to pay when following up for delinquent accounts.
Input parameter value is numeric.

AUD_QUEUE_INITIAL_CRB_FAILED This parameter enabling will Queue the application
if any bureau failed.
UIX_UCS CUA MAX FOLLOWUP_DAYS This parameter will allow the user to maintain the

Collections maximum follow-up days that are
allowed in the system.

XSL_TAX_INTERFACE This parameter is used to specify the sales tax
interface in OFSLL. Input parameter value is user
defined. In this case it is held as Manual.

CMN_SYSTEM_UNDER_MAINTENANCE This parameter specifies whether the system is
under maintenance or not. Input parameter value is
Boolean (Yes/No).

CMN_GL_POST_DT This parameter is used to define the GL Post Date
of Company in MM/DD/YYYY format. The same is
also updated by Scheduler if ENABLED.

PTX_TXN_LAST PURGE_DT This parameter stores the date when transactions
were purged last in the OFSLL system. Input
parameter value is date.

PUP_TUP_LAST_PURGE_ DT This parameter stores the date when transactions
upload were purged last in the OFSLL system.
Input parameter value is date.

JSC_START_OF BUSINESS TIME This parameter is used to set the start of business
time. Input parameter value is time in 24 hour
format.
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Parameter

Description

CMN_PROMISE_FUTURE_MTHD

This parameter helps to define the future promise
handling method in the system.

When multiple Promise to Pay records are defined

on an account and if any one of the promise is not

satisfied i.e. if there is no credit / Payment

transaction of the corresponding amount on the

promise date, then system uses any of the

following method defined in this parameter to

update the future promises.

*  No Action on future promises (default)

*  Mark current and future promises as broken

e Mark current as broken but future promise as
cancelled

C.5 Other Parameters

The following additional set of parameters are also available to control system specific data

ORACLE

and other administration process.

Table C-4 Other Parameters

Parameter

Description

CRB_MAX_BUREAU_PULL

This parameter is used to determine the number of
credit reports automatically per applicant. Input
parameter value is numeric.

CRB_ALL_APL_BUREAU_PULL

This parameter is used to set up whether credit
bureau reports should be pulled for the primary
applicant only or to all other applicants also (for
joint applications), regardless of their relationship
with the primary applicant. Input parameter value is
Boolean (Y/N).

CBU_FILE_FREQUENCY

This parameter is used to set the Metro Il File
Frequency and determine whether output file is to
be generated daily or monthly. If this is monthly,
then output file is written with daily data but
generated monthly.

JOINT_DEDUP_ SPOUSE_LIABILITIES

This parameter is used to determine duplicate
liabilities in the Spouse’s liabilities in de-duping
logic. Input parameter value is Boolean (Yes/No).

JOINT_DEDUP_ALLAPL_LIABILITIES

This parameter is used to determine duplicate
liabilities of all applicants’ liabilities in de-duping
logic, irrespective of whether they are related to
each other. Input parameter value is Boolean (Yes/
No).

ASC_COL_SER_ENABLED_IND

This parameter is used for enabling the Collection
Servicing Indicator. Input parameter value is
Boolean (Y/N).

CMN_TEST_TOOL_LOGGING

This parameter is used to set the testing tool
logging to enable or disable testing tool log in. Input
parameter value is Boolean (Yes/No).
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Description

ICA_INPUT_FILE_FORMAT

This parameter is used to specify the Input format
for call activity file. Two Parameter values are
possible — US format and OFSLL format.

JSV_BI_USER

This parameter is used to define the Bl publisher
User ID. Input parameter value is user defined
(Admin user).

JSV_BI_PASSWORD

This parameter is used to define the Bl publisher
User password. Input parameter value is user
defined (Admin user).

PJR_COPY_PURGED_DATA

This parameter is used to specify whether data
should be copied into the purge tables or not. Input
parameter value is Boolean (Yes/No).

PUP_ARCHIVE_DAYS

This parameter is used to specify the number of
days after which the transactions upload details are
to be archived. Input parameter value is numeric.

PUP_OARCHIVE_DAYS

This parameter is used to specify the number of
days after which the transactions upload details are
to be moved from O tables. Input parameter value
is numeric.

TPE_APPLY_LTC_FROM_CURR_DUE_DT

This parameter is used to specify whether late
charge should be applied from current due date for
Pyramid Law fee method. Input parameter value is
Boolean (Yes/No).

TPE_EXCESS_PAYMENT_TO_MEMO

This parameter will make excess payment to the
memo payment by marking this Parameter as YES.

TPE_STOP_COMP_DELQ _DAYS

This parameter is enabled to stop computation if
the account is delinquent for more than 60 days.
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